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1 歡迎

非常感謝您購買 HP Photosmart D7100 series 印表機！使用此新型相片印表
機，不論是否使用電腦，您都可以列印精美的相片、儲存相片到電腦以及製作簡
易有趣的專案。

本手冊主要說明如何在不連接電腦的情況下列印。若要了解如何從電腦列印，請
安裝印表機軟體並檢視電子說明。如需關於利用電腦使用印表機的概述，請參
閱從電腦列印。如需安裝軟體的詳細資訊，請參閱「快速入門」指南。

家庭使用者可了解如何：

● 從印表機或電腦列印無邊框相片
● 選擇相片版面
● 將彩色相片轉換成黑白相片，或套用色彩效果，如：褐色或古董色

印表機隨附以下說明文件：

● 快速入門指南：「快速入門指南」說明如何安裝印表機和印表機軟體，以及
如何開始列印您的第一張相片。

● 使用者指南：「使用者指南」就是您正在閱讀的這本書。描述印表機的基本
功能，說明如何在不連接電腦的情況下使用印表機，亦包含硬體疑難排解資
訊。

● 螢幕說明：螢幕「HP Photosmart 說明」描述如何利用電腦使用本印表機，
並包含軟體疑難排解資訊。

特殊功能
新功能與材質使製作高品質相片變得更加容易：

● 在使用新款 HP 進階相紙 (在某些國家/地區也稱為 HP 相紙) 時，印表機中
的特殊感應器會偵測到相紙背面的標記，並且會自動選取最佳的列印設定。
如需此新款相紙的詳細資訊，請參閱選擇適用的紙張。

● HP Real Life 技術讓您可輕易獲得品質更佳的相片。自動消除紅眼和用來增
強陰影中細節效果的適應照明僅是其中一些技術。您可以從印表機軟體中獲
取許多編輯和增強選項。若要從控制台存取這些功能，請參閱提高相片品
質。若要了解如何在軟體中找到這些功能，請參閱 HP Real Life 技術功能。

存取螢幕 HP Photosmart 說明
在電腦上安裝好 HP Photosmart 軟體後，您便可以檢視螢幕 HP Photosmart 說
明：

● Windows PC：從「開始」功能選項，選取「程式集」 (在 Windows XP
中，則選取 「所有程式」) >「HP」>「HP Photosmart D7100 series」>
「Photosmart 說明」。

● Macintosh：在 Finder「輔助說明」選單中，選擇「Mac 輔助說明」。在輔
助說明檢視器「程式庫」選單中，選擇「HP PhotosmartMac Help」
(HP Photosmart Mac 輔助說明)。
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印表機零件

印表機正面

1 開啟：按此按鈕可以開啟印表機電源。

2 頂蓋：提起此蓋可以拿放墨匣以及清除卡紙。若要提起此蓋，請抓住 HP 標誌下面
的頂蓋並向上拉起。

3 印表機螢幕：使用此螢幕可以檢視相片、功能選項及訊息。

4 出紙匣：此紙匣用於接住印好的紙張。提起此匣可使用相片匣。

5 主紙匣：拉出此紙匣可放入紙張、投影片、信封或其他材質，列印面朝下。

6 相片匣：提起出紙匣並拉出此匣，可在相片匣中放入最大尺寸至 10 x 15 公分

(4 x 6 英吋) 的小型相紙 (讓列印面朝下) 以進行列印。相紙可以是含標籤或不含標
籤。

7 記憶卡插槽：在此插入記憶卡。如需支援的記憶卡清單，請參閱插入記憶卡。

8 相機連接埠：連接 PictBridge™ 數位相機、選購的 HP Bluetooth® 無線印表機轉接器

或 iPod。

印表機的背面

1 電源線連接：使用此連接埠連接印表機附帶的電源線。

2 USB 埠：使用此連接埠將印表機連接至電腦。

3 後方機門：卸下此門可以清除卡紙或安裝選購的 HP 自動雙面列印配件。請參閱選
用配件。

第 1 章
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主紙匣與出紙匣

1 紙張寬度導板：調整此導板使其緊靠主紙匣中紙疊的邊緣。

2 出紙匣：此紙匣用於接住印好的紙張。提起此匣可以使用相片匣。

3 出紙匣延伸架：朝您自己的方向拉開，可以延伸出紙匣來接住印出的紙張。

4 主紙匣：拉出此紙匣可放入一般紙張、投影片、信封或其他材質，列印面朝下。

5 主紙匣把手：朝您自己的方向拉開，可以延伸主紙匣。

6 紙張長度導板：調整此導板使其緊靠主紙匣中紙張的末端。

相片匣

1 紙張寬度導板：調整此導板使其緊靠相片匣中紙疊的邊緣。

2 紙張長度導板：調整此導板使其緊靠相片匣中紙張的末端。

3 相片匣把手：朝您自己的方向拉開，可以延伸相片匣。

HP Photosmart D7100 series 使用者指南 9



控制台

1 開啟：開啟印表機電源或將其置入省電模式。

2 上一頁：一次退回一個畫面。

3 首頁：按下此按鈕可返回首頁畫面。

4 導覽箭頭：調整裁剪方塊、導覽功能選項，以及控制視訊片段的播放。

5 OK：選取反白強調的項目、功能選項或對話方塊選項，以及在播放期間播放/暫停
視訊片段。

6 預覽列印：預覽檢視選取的一張或多張相片。

7 列印：從插入的記憶卡或從連接到前方相機連接埠的相機，列印選取的相片。

8 取消：停止列印工作。

9 旋轉：旋轉相片或裁剪方塊。

10 縮放 (+)(-)：放大或縮小相片或裁剪方塊。您也可以在以正常放大倍數檢視相片時

按「縮放 (-)」，一次檢視四張相片。

11 相片修復：自動增強相片效果，並將照明、對比、對焦及消除紅眼等功能套用至
所有列印的相片。

指示燈

1 開啟燈號：開啟印表機電源時一直呈藍色亮起，關閉電源時熄滅。

2 注意燈號：出現錯誤狀況時會閃爍。如需出錯狀況的指示或詳細資訊，請參閱印表
機螢幕。如需詳細資訊，請參閱注意燈號亮起。

3 列印燈號：印表機開啟並準備好列印時一直呈藍色亮起，印表機正在列印或忙於自
我維護時呈藍色閃爍。

4 相片修復燈號：相片修復功能開啟時一直呈藍色亮起。

5 記憶卡燈號：插入記憶卡時一直呈藍色亮起，當印表機存取記憶卡時會閃爍，未插
入記憶卡或插入超過一張記憶卡時會熄滅。請參閱印表機螢幕以取得相關指示。
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選用配件
印表機有一些選用配件可增強便攜性，以便在任何時間和地點列印。配件的外觀
可能與顯示的有所不同。

要購買耗材，請瀏覽：

● www.hpshopping.com (美國)
● www.hp.com/go/supplies (歐洲)
● www.hp.com/jp/supply_inkjet (日本)
● www.hp.com/paper (亞太地區)

配件名稱 描述

HP  自動雙面列印配件

此配件會自動翻轉每頁以列印雙面。
您可以節省費用 (雙面列印會減少紙張
的消耗) 和時間 (無需取出紙張再將它
重新放回)，並且更容易管理大型文件。

並非在所有國家/地區都提供此配件。

HP Bluetooth® 無線印表機轉接器

1 將 Bluetooth 轉接器插入前方相機
連接埠

HP Bluetooth® 無線印表機轉接器需插
入印表機前方的相機連接埠。此轉接
器讓您從許多支援 Bluetooth 功能的裝
置 (包括數位相機、照相手機，以及
PDA) 使用 Bluetooth 無線技術列印。

如需關於使用此配件進行列印的更詳
細資訊，請瀏覽 www.hp.com/go/
bluetooth。

印表機功能選項
按一下首頁按鈕以進入首頁畫面。您可以從首頁畫面及「設定」功能選項存取所
有功能。
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檢視與列印

「精靈」：使用精靈來引導您完成列印程序。也可使用精靈來改善相片品質，以
及套用進階相片效果 (例如亮度及色彩效果)。
「4×6」：用於列印 4×6 英吋 (10 × 15 公分) 的相片。

「放大」：使用「放大」來列印不同尺寸的相片。

「全部列印」：選取後可列印插入印表機之記憶卡上的所有相片。

「其他列印專案」：使用「其他專案」來列印全景、HP CD/DVD 標籤、皮夾相
片及護照相片。

– 「全景列印」：選取後可「開啟」或「關閉」(預設值) 全景列印。選取「開
啟」以 3:1 的長寬比列印所有選取的相片；在列印之前放入 10 x 30 公分 (4
x 12 英吋) 的紙張。

– 「HP CD/DVD 標籤」：選取後可列印 CD/DVD 標籤。
– 「皮夾相片」：用於列印皮夾尺寸的相片。
– 「護照相片」：選取後可列印護照相片。

儲存檔案

選取「儲存檔案」，將您選取的影像儲存至連接的電腦上。

共享

使用「共享」，透過「HP Photosmart 共享」來選取並共享相片。

設定

● 工具：使用工具來顯示墨水容量、調整列印品質、列印樣本頁、列印測試
頁，以及清潔並校正墨匣。

– 顯示墨水容量：用於在首頁畫面上顯示墨水容量。
– 「列印樣本頁」：選取後可列印樣本頁，這在檢查印表機的列印品質時

很有用。此功能並未在所有印表機機型上提供。
– 「列印測試頁」：選取後可列印包含有關印表機疑難排解資訊的測試頁。
– 「清潔列印頭」：選取後可在相片上出現白色線條或條紋時清潔列印

頭。完成清潔後，印表機將列印一份自我測試報告。如果報告顯示列印
品質有問題，您可以選擇再次清潔列印頭。

– 「校正印表機」：選取後可在相片上出現白色線條或條紋時校正印表機。
● Bluetooth

– 「裝置位址」：某些具有 Bluetooth 無線技術的裝置需要您輸入要尋找之
裝置的位址。此功能表選項會顯示印表機位址。

– 「裝置名稱」：您可以為印表機選擇名稱，讓其他具有 Bluetooth 無線技
術的裝置在找到印表機後顯示這個名稱。

– 「總金鑰」：當印表機的 Bluetooth「安全級別」設為「高」時，您必須
輸入總金鑰才能讓其他 Bluetooth 裝置可以使用印表機。預設的總金鑰
是 0000。

– 「可見性」：選取「全部可見」(預設值) 或「不可見」。當「可見性」設
為「不可見」時，只有知道印表機位址的裝置才能從印表機列印。
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– 「安全級別」：選取「低」(預設值) 或「高」。「低」設定不會要求使
用 Bluetooth 無線技術之其他裝置的使用者輸入印表機總金鑰。「高」
會要求使用 Bluetooth 無線技術之其他裝置的使用者輸入印表機總金鑰。

– 「重設 Bluetooth 選項」：選取後可將 Bluetooth 功能表中的所有項目
重設為其預設值。

● 說明功能選項：使用說明功能選項，取得印表機的使用指示。

– 「墨匣」：選取後可看到如何安裝墨匣的動畫。
– 「主紙匣放入」：選取後可閱讀在主紙匣中放入紙張的指示。
– 「相片匣放入」：選取後可閱讀在相片匣中放入紙張的指示。
– 「卡紙」：選取後可看到如何清除卡紙的動畫。
– 「相機連接」：選取後可閱讀有關如何將 PictBridge 相機連接到印表機

的指示。
● 偏好設定

– 4 × 6 列印紙張尺寸：選擇「列印前詢問」，以便在每次列印時選取紙張
類型及尺寸 (預設值)。

– 「列印品質」：選擇「最佳」(預設值) 或「一般」列印品質。
– 「紙張類型」：選取「自動」(預設值)，印表機就會自動偵測紙張類型及

尺寸。
– 「日期戳記」：使用此選項可將日期與/或時間加到印好的相片上。
– 色彩空間：選擇一個色彩空間。「自動選擇」(預設值) 告訴印表機使用

Adobe RGB 色彩空間 (如果可用)。如果無法使用 Adobe RGB，根據預
設，印表機將會使用 sRGB。

– PictBridge 紙匣選擇：用於選取在透過 PictBridge 連接列印時預設使用
的紙匣。

– 「視訊增強」：選取「開啟」(預設值) 或「關閉」。當您選取「開啟」
時，從視訊片段列印的相片品質會改善。

– 「還原原廠預設值」：除了「選取語言」和「選取國家/地區」(在「偏好
值」功能選項的「語言」中) 以及 Bluetooth 設定 (在印表機主功能選項
的「Bluetooth」下) 之外，將所有功能選項項目還原為其出廠時的預設
設定。此設定不會影響「HP Instant Share」或「網路」預設值。
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2 準備列印

本節包括下列主題：

● 放入紙張
● 插入墨匣
● 插入記憶卡

放入紙張
了解如何為列印工作選擇合適的紙張，以及如何將紙張放入進紙匣以進行列印。

選擇適用的紙張

使用 HP 進階相紙。此種相紙是為了與印表機中的墨水搭配使用所設計的，可以
產生精美的相片。

如需可用 HP 相紙的清單，或是要購買耗材，請造訪：

● www.hpshopping.com (美國)
● www.hp.com/eur/hpoptions (歐洲)
● www.hp.com/jp/supply_inkjet (日本)
● www.hp.com/paper (亞太地區)
依預設，印表機會設定為在 HP 高級相紙上列印最佳品質的相片。如果您在不同
種類的紙張上列印，請務必在印表機功能選項中變更紙張類型。請參閱印表機功
能選項。

放入紙張訣竅

裝入紙張訣竅：

● 以列印面朝下的方式放入紙張。
● 您可以在各種尺寸的紙張上列印相片和文件，包括從 8 x 13 公分 (3 x 5 英

吋) 到最大尺寸為 22 x 61 公分 (8.5 x 24 英吋) 的紙張。10 x 15 公分 (4 x 6
英吋) 相紙有含標籤或不含標籤兩種。

● 放入紙張前，先拉出主紙匣，然後將紙張寬度導板和紙張長度導板向外滑
動，留出紙張的空間。放入紙張後，調整導板，使其緊靠紙張邊緣而不會彎
曲紙張。紙張放入完成後，將主紙匣完全推回去。

● 一次僅在相同的紙匣中放入一種類型及尺寸的紙張。
● 放入紙張後，請拉出出紙匣延伸架，並將後檔板抬起以接住印好的頁面。

放入主紙匣

任何支援的相片或一般紙張材質

1. 拉出主紙匣。

2. 將紙張寬度導板和紙張長度導板滑動到最外邊的位置。

3. 以列印面朝下的方式放入紙張。請確認整疊紙輕靠在紙張長度導板上的固定
夾下方。
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1 紙張寬度導板

2 紙張長度導板

4. 向內調整紙張寬度導板和紙張長度導板直到停在紙疊的邊緣。

5. 將主紙匣完全向內推入。

1 將主紙匣完全向內推入

放入相片匣

可使用最大尺寸至 10 x 15 公分 (4 x 6 英吋) 含標籤或不含標籤的相紙、Hagaki
卡、A6 卡、L 尺寸卡。

1. 提起出紙匣並拉出相片匣。

2. 向外調整紙張寬度導板和紙張長度導板，留出紙張的空間。

1 出紙匣

2 紙張寬度導板

3 紙張長度導板

3. 在相片匣中最多放入 20 張紙，並讓列印面朝下。如果使用含標籤的相紙，
插入紙張時，請將含標籤那一側靠近您。

4. 向內調整紙張寬度導板和紙張長度導板直到停在紙疊的邊緣。請確認整疊紙
輕靠在紙張長度導板上的固定夾下方。

5. 推入相片匣。

6. 關閉出紙匣。
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1 紙張寬度導板

2 紙張長度導板

3 相片匣把手

插入墨匣
在您第一次安裝與使用 HP Photosmart 時，請務必安裝印表機隨附的墨匣。這
些墨匣中的墨水是特別配製與列印頭組件中的墨水混合。

購買替換墨匣

在購買替換墨匣時，請參閱本指南封底的墨匣編號。這些墨匣編號可能依國家/
地區而異。

附註 如果您已多次使用印表機並且已安裝 HP Photosmart 印表機軟體，
您也可以在印表機軟體中找到墨匣編號。Windows 使用者：在 Windows
工作列中的 HP Digital Imaging Monitor 圖示上按一下滑鼠右鍵，然後選
取「啟動/顯示 HP 解決方案中心」。選取「設定」，然後選取「列印設
定」，再選取「印表機工具箱」。按一下「估計的墨水存量」標籤，然後
按一下「墨匣資訊」。若要訂購墨匣，請按一下「線上訂購」。Mac 使
用者：在 Dock 中，按一下「HP Photosmart Studio」。在
HP Photosmart Studio 工具列中，按一下「Devices」(裝置)。從
「Information and Settings」(資訊與設定) 彈出式選單選擇「Maintain
Printer」(維護印表機)，然後按一下「Launch Utility」(啟動工具程式)。
在「Configuration Settings」(組態設定) 清單中，按一下「Supply Info」
(耗材資訊)。
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墨匣訣竅

HP Vivera 墨水提供逼真的相片品質以及傑出的防褪色效果，能永保持久的鮮豔
色彩。HP Vivera 墨水是特別配製並已透過科學方法進行品質、純度和防止褪色
方面的測試。

為了獲得最佳列印品質，對於從零售商處購買的所有列印墨匣，HP 建議您在包
裝盒上的安裝有效期之前安裝。

為了獲得最佳列印效果，HP 建議您僅使用原廠 HP 墨匣進行列印。原廠 HP 墨
匣是專為 HP 印表機設計，並通過在 HP 印表機上的測試，可在多次使用後仍能
產生精美的列印效果。

附註 HP 無法保證非 HP 墨水的品質和可靠性。因使用非 HP 墨水導致
印表機故障或損壞而引起的印表機服務或維修，不在保固範圍內。

墨匣

1 請勿將物件插入這些孔內

注意 防止墨水流失或溢出：搬運印表機時，將墨匣留在印表機內，並且
避免將用過的墨匣長時間留在印表機外。

墨匣保固資訊

當 HP 墨匣用於其專屬的 HP 列印裝置時，皆適用 HP 墨匣保固。此項保固不涵
蓋重新填裝墨水、重新製造、重新換新、使用不當或經過改裝的 HP 墨水產品。

在保固期限之內，只要 HP 墨水尚未用完或尚未超過保固到期日，產品都在保固
範圍內。在產品上可以找到格式為 YYYY/MM/DD (年/月/日) 的保固到期日，如
下圖所示：

如需 HP 有限保固聲明的副本，請參閱 HP 保固。

第 2 章

18 HP Photosmart D7100 series



插入或更換墨匣

1. 確定電源開啟，然後提起頂蓋。確定從印表機內部取出所有包裝材料。

2. 擠壓墨匣插槽下面的灰色標籤以釋放印表機內部的灰色卡榫，然後提起卡
榫。
墨匣區域具有顏色編碼以方便對照。提起適當顏色下面的卡榫以插入或更換
墨匣。墨匣的顏色從左到右，分別是黑色、黃色、淡青藍色、青藍色、淡洋
紅色及洋紅色。

1 黑色墨匣的墨匣卡榫

2 彩色墨匣的墨匣區域

3. 如果您要更換墨匣，請將舊墨匣朝向您自己方向拉出插槽以將它取出。

回收舊墨匣。HP 噴墨耗材回收計劃在許多國家/地區皆有提供，免費為您回
收用過的墨匣。如需更詳細的資訊，請瀏覽 www.hp.com/hpinfo/
globalcitizenship/environment/recycle/inkjet.html。

4. 從包裝中取出新的墨匣，握住把手，將墨匣滑入空的插槽。
確定您插入墨匣的插槽具有與新墨匣相同形狀的圖示與顏色。在插入墨匣時
銅色接點必須面向印表機。
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附註 在您第一次安裝與使用印表機時，請務必安裝印表機隨附的墨
匣。這些墨匣中的墨水是特別配製與列印頭組件中的墨水混合。

5. 將灰色卡榫向下壓直到它卡入到位。

6. 為您要更換的每個墨匣重複步驟 2 至 5。
您必須安裝所有六個墨匣。如果有一個墨匣缺失，印表機將無法正常操作。

7. 合上頂蓋。

插入記憶卡
使用數位相機拍照之後，您可以從相機中取出記憶卡，將其插入印表機以檢視和
列印相片。本款印表機可以讀取下列類型的記憶卡：CompactFlash™、Memory
Sticks、Microdrive™、MultiMediaCard™、Secure Digital™ 和 xD-Picture Card™。

注意 使用其他任何類型的記憶卡可能會損壞記憶卡和印表機。

若要了解如何用其他方法將數位相機中的相片傳輸到印表機，請參閱連接到其他
裝置。

支援的檔案格式

此印表機可辨識下列檔案格式，並可直接從記憶卡列印：JPEG、未壓縮的
TIFF、Motion JPEG AVI、Motion-JPEG Quicktime 和 MPEG-1。如果您的數位
相機以其他檔案格式儲存相片和視訊片段，請先將檔案儲存到電腦，再利用軟體
程式進行列印。如需詳細資訊，請參閱電子版說明。
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插入記憶卡

記憶卡插槽

1 xD-Picture Card
2 Memory Stick
3 Compact Flash I 和 II、Microdrive
4 Secure Digital、MultiMediaCard (MMC)

記憶卡類型

請在下表中尋找您的記憶卡，並按照相應的指示將記憶卡插入印表機。

操作指引：

● 一次僅插入一張記憶卡。
● 將記憶卡輕輕推入印表機，直到卡停住為止。記憶卡插槽只允許將部份記憶

卡插入印表機；請勿嘗試硬將整個記憶卡插入印表機。
● 當記憶卡插入正確時，記憶卡燈號將會閃爍，然後一直亮起為綠色。

注意 1 使用任何其他方法插入記憶卡可能會損毀記憶卡和印表機。

注意 2 當記憶卡燈號呈綠色閃爍時，請勿拔出記憶卡。如需詳細資訊，
請參閱取出記憶卡。

記憶卡 記憶卡插入方式

CompactFlash ● 正面標籤朝上，如果標籤有箭頭，箭頭應指向印表機
● 有金屬針孔的一邊先插入印表機
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記憶卡 記憶卡插入方式

Memory Stick ● 缺角在左邊
● 金屬接點面朝下
● 如果您使用 Memory Stick Duo 或 Memory Stick PRO

Duo 卡，請先連接記憶卡隨附的轉接器，再將記憶卡插入印
表機

Microdrive ● 正面標籤朝上，如果標籤有箭頭，箭頭應指向印表機
● 有金屬針孔的一邊先插入印表機

MultiMediaCard ● 缺角在右邊
● 金屬接點面朝下

Secure Digital ● 缺角在右邊
● 金屬接點面朝下

xD-Picture Card ● 記憶卡弧形的一邊朝向您自己
● 金屬接點面朝下

取出記憶卡

請等候至記憶卡指示燈停止閃爍，然後輕輕拔出以將其從印表機中取出。

注意 切勿在記憶卡指示燈閃爍時取出記憶卡。記憶卡指示燈閃爍表示印
表機正在存取記憶卡。在記憶卡被存取時將其取出可能會損壞印表機，或
者破壞記憶卡上的資訊。
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3 列印相片時不連接電腦

HP Photosmart D7100 series 印表機甚至可讓您不必開啟電腦，便能選取、增
強及列印相片。在您依照「快速入門」手冊中的指示設定印表機後，就可以將記
憶卡插入印表機，然後使用印表機控制台上的按鈕來列印相片。

您也可以直接從數位相機列印相片。如需詳細資訊，請參閱從數位相機列印相
片。

列印相片
按照下列數種方法，不使用電腦也可以列印相片：

● 將內含相片的記憶卡插入印表機的記憶卡插槽
● 將 PictBridge 數位相機連接到印表機前方的相機埠
● 安裝選購的 HP Bluetooth® 無線印表機轉接器，使用 Bluetooth 無線技術從

數位相機列印

從記憶卡列印相片

您可以將記憶卡插入印表機以從記憶卡列印相片，並且使用印表機控制台檢視、
選擇、增強以及列印相片。您也可以直接從記憶卡列印相機選擇的相片，亦即標
示為使用數位相機列印的相片。

從記憶卡列印會很快速且便捷，而且不會耗盡數位相機的電池電力。

列印一張或多張相片

列印之前，請確定您已將記憶卡插入印表機，並已在要使用的紙匣中放入正確的
紙張。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「4×6」，或選取「放大」以選擇您想要的相片尺寸，然後按「OK」。
3. 選取您想要的紙張尺寸，然後按「OK」。
4. 選取版面，然後按「OK」。
5. 使用箭頭按鈕，捲動所有可用的相片。

6. 按「OK」，選取一個或多個影像。

– 按「縮放 -」，最多可在印表機螢幕上檢視 9 個影像。
– 按向上鍵，增加選取影像的列印份數。

7. 按「列印」以列印選取的相片。

檢查相片匣指示燈確認已選取正確的紙匣；主紙匣指示燈應該熄滅，而相片匣指
示燈則應亮起。
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列印記憶卡上的所有相片

列印之前，請確定您已將記憶卡插入印表機，並已在要使用的紙匣中放入正確的
紙張。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「全部列印」。

3. 選取您想要的紙張尺寸，然後按「OK」。

➔ 選取版面，然後按「OK」。
4. 選取「立即列印」，然後按「OK」。

列印記憶卡中相機選擇的相片

當您使用數位相機選擇要列印相片時，該相機會建立數位列印順序格式 (DPOF)
檔案，用來標示選定的相片。印表機可以直接從記憶卡讀取 DPOF 1.0 及 1.1 的
檔案。

1. 使用數位相機選取您要列印的相片。 如需更詳細的資訊，請參閱相機隨附
的文件。

2. 如果使用相機選取預設作為相片版面，請按「版面」以選取相片版面。
如果使用相機選取預設以外的相片版面，則相片會以相機選擇的版面列印，
而不考慮印表機設定。

3. 放入所需的紙張。

4. 從數位相機取出記憶卡，並將它插入印表機。

5. 當印表機螢幕上出現訊息詢問您是否要列印相機選擇的相片時，請按
「OK」。
隨即便會開始列印您使用相機選擇的相片。

如果印表機找不到或無法讀取記憶卡上所有相機選擇的相片，它將只會列印可以
讀取的相片。

列印完畢後，印表機便會刪除 DPOF 檔案， 並取消相片的標記。

使用精靈進行列印

列印精靈提供對相片進行選取、調整大小、編輯及列印的詳細指示。

附註 也可使用精靈來改善相片品質，以及套用進階相片效果 (例如亮度
及色彩效果)。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「精靈」，然後按「OK」。
3. 依照提示列印您想要的相片。

從視訊片段列印相片

您可以在印表機螢幕上檢視視訊片段，並選取及列印個別的畫面。

當您第一次插入含有視訊片段的記憶卡時，印表機會使用視訊片段的第一個畫
面，在印表機螢幕上用來代表該片段。
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印表機可以辨識以下列幾種格式錄製的視訊片段：

● Motion-JPEG AVI
● Motion-JPEG QuickTime
● MPEG-1
印表機會忽略其他格式的視訊片段。

列印之前，請確定您已將記憶卡插入印表機，並已在要使用的紙匣中放入正確的
紙張。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「4×6」，或選取「放大」以選擇您想要的相片尺寸，然後按「OK」。
3. 選取您想要的紙張尺寸，然後按「OK」。
4. 使用向左鍵及向右鍵來捲動並選取可用的視訊。

附註 視訊會在影像中央顯示攝影機圖示。

5. 按向上鍵以播放視訊。

6. 若要選取想要列印的畫面，請按向上鍵以暫停視訊。您必須先暫停視訊，才
能選取想要列印的畫面。

7. 按「OK」以選取您想要列印的畫面。
8. 按「列印」以列印選取的畫面。

列印相片索引頁

相片索引頁顯示記憶卡上最多 2000 張相片的縮圖檢視和索引編號。使用一般紙
張而不是相紙來列印索引頁，可以節省成本。

相片索引頁可能長達數頁。

列印之前，請確定您已將記憶卡插入印表機，並已在要使用的紙匣中放入正確的
紙張。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「全部列印」，然後按「OK」。
3. 選取 8.5×11 紙張。
4. 選取索引頁圖示 (每頁有 16 個影像)，然後按「OK」。

停止列印

若要停止進行中的列印工作，請按「取消」。

從數位相機列印相片

您可以使用 USB 纜線將 PictBridge 數位相機直接連接到印表機的相機連接埠進
行相片列印。如果您的數位相機配備 Bluetooth 無線技術，則可以在印表機插入
選購的 HP Bluetooth® 無線印表機轉接器，並以無線的方式傳送相片至印表機。

從數位相機進行列印時，印表機會使用您在相機上選取的設定。如需更詳細的資
訊，請參閱相機隨附的說明文件。
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配備 Bluetooth 無線技術的數位相機

如果您的數位相機配備 Bluetooth 無線技術，則可以購買選購的 HP Bluetooth®

無線印表機轉接器，並使用 Bluetooth 無線連線從相機列印。

附註 您也可以使用 Bluetooth 無線技術從其他裝置列印，例如 PDA 或照
相手機。如需詳細資訊，請參閱連接到其他裝置與 Bluetooth 轉接器隨附
的說明文件。

1. 使用印表機螢幕上的 Bluetooth 功能選項為印表機設定 Bluetooth 選項。如
需詳細資訊，請參閱設定。

2. 放入印表機紙張。

3. 將 HP Bluetooth® 無線印表機轉接器插入印表機前方的相機連接埠。
當轉接器準備好接收資料時，轉接器上的指示燈會閃爍。

4. 按照數位相機隨附的說明文件中的指示，將相片傳送到印表機。

配備 PictBridge 技術的數位相機

1. 開啟 PictBridge 數位相機，並選取您想要列印的相片。
2. 放入紙張。

3. 確定相機在 PictBridge 模式下，然後使用相機隨附的 USB 纜線將相機連接
到印表機前方的相機連接埠。
印表機辨識出 PictBridge 相機後，即會自動列印選定的相片。

從 iPod 列印相片

如果您有可以儲存相片的 iPod，則可將 iPod 連接到印表機並列印相片。

開始之前

檢查您複製到 iPod 的影像是否為 JPEG 格式。

附註 iPod 在您的國家/地區可能尚未提供。

將相片匯入 iPod
1. 使用 Belkin Media Reader for iPod 讀卡機將相片從記憶卡複製到您的

iPod。
2. 透過選取 iPod 選單上的「相片輸入」來確認相片已在 iPod 上。相片會顯示

為「捲筒」。

從 iPod 列印相片

1. 使用 iPod 隨附的 USB 纜線，將 iPod 連接到印表機前方的相機連接埠。讀
取相片時，印表機螢幕會顯示「正在讀取裝置」數分鐘。然後，相片會出現
在印表機螢幕上。

2. 選擇您要列印的相片，並按「列印」。如需選取和列印相片的詳細資訊，請
參閱列印相片。
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相片版面
從「檢視與列印」功能選項選擇您想要的列印功能，再按「OK」選定所需的列
印功能，然後選擇您想要的紙張尺寸與版面。

版面 紙張尺寸 (相片尺寸)

每頁 1 張相片，無邊框 4 x 6 英吋 (4 x 6 英吋)
10 x 15 公分 (10 x15 公分)
5 x 7 英吋 (5 x 7 英吋)
8.5 x 11 英吋 (8.5 x 11 英吋)

每頁 1 張相片 3.5 x 5 英吋 (3.25 x 4.75 英吋)
4 x 6 英吋 (3.75 x 5.75 英吋)
10 x 15 公分 (9.53 x 14.6 公分)
5 x 7 英吋 (4.75 x 6.75 英吋)
8 x 10 英吋 (7.75 x 9.75 英吋)
8.5 x 11 英吋 (8 x 10 英吋)
A6 (9.86 x 14.16 公分)
A4 (20 x 25 公分)
Hagaki (9.36 x 14.16 公分)
L (8.25 x 12.06 公分)

每頁 2 張相片 3.5 x 5 英吋 (2.25 x 3.25 英吋)
4 x 6 英吋 (2.75 x 3.75 英吋)
5 x 7 英吋 (3.25 x 4.75 英吋)
8 x 10 英吋 (4.75 x 6.5 英吋)
8.5 x 11 英吋 (5 x 7 英吋)
A6 (6.92 x 9.86 公分)
A4 (13 x 18 公分)
Hagaki (6.8 x 9.36 公分)
L (5.87 x 8.25 公分)

每頁 3 張相片 3.5 x 5 英吋 (1.5 x 2.25 英吋)
4 x 6 英吋 (1.75 x 2.625 英吋)
5 x 7 英吋 (2.25 x 3.375 英吋)
8 x 10 英吋 (3.33 x 5 英吋)
8.5 x 11 英吋 (4 x 6 英吋)
A6 (4.77 x 7.15 公分)
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版面 紙張尺寸 (相片尺寸)
A4 (10 x 15 公分)
Hagaki (4.52 x 6.78 公分)
L (3.96 x 5.94 公分)

每頁 4 張相片 3.5 x 5 英吋 (1.5 x 2.25 英吋)
4 x 6 英吋 (1.75 x 2.5  英吋)
5 x 7 英吋 (2.2 x 3.25 英吋)
8 x 10 英吋 (3.5 x 4.75 英吋)
8.5 x 11 英吋 (3.5 x 5 英吋)
A6 (4.77 x 6.92 公分)
A4 (9 x 13 公分)
Hagaki (4.52 x 6.5 公分)
L (3.96 x 5.7 公分)

每頁 9 張相片 3.5 x 5 英吋 (1 x 1.375 英吋)
4 x 6 英吋 (1.125 x 1.5 英吋)
5 x 7 英吋 (1.5 x 2 英吋)
8 x 10 英吋 (2.25 x 3 英吋)
8.5 x 11 英吋 (2.5 x 3.25 英吋)– 皮夾
尺寸

A6 (3.07 x 4.05 公分)
A4 (6.4 x 8.4 公分)
Hagaki (2.9 x 3.86 公分)
L (2.53 x 3.36 公分)

附註 印表機可能會旋轉相片以適合版面。

提高相片品質
印表機會提供數種增強功能，可提高從記憶卡列印的相片品質。這些列印設定不
會變更原始相片。僅會影響列印。

調整亮度不足的相片

1. 選擇「檢視 與列印」，然後按「OK」。
2. 選取「精靈」，然後按「OK」。
3. 依照螢幕指示來選取紙張尺寸及相片，然後按「OK」來檢視功能選項。
4. 選取「編輯相片」，然後按「OK」。
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5. 選取「相片亮度」，然後按「OK」。
6. 按  及 ，將相片亮度增減至您想要的程度，然後按「OK」。

消除相片中的紅眼

當您開啟「相片修復」功能時，便會啟用自動消除紅眼功能。啟用「相片修復」
功能時，便會將智慧型聚焦、適應照明及消除紅眼功能套用於選取的相片上。

➔ 按「相片修復」以啟用「相片修復」功能。

調整品質不佳的視訊片段

此偏好值會影響列印自視訊片段的相片。

提高列印自視訊片段的相片品質

1. 選取「設定」，然後按「OK」。
2. 使用箭頭按鈕尋找並選取「偏好設定」，然後按「OK」。
3. 使用箭頭按鈕尋找並選取「視訊增強」，然後按「OK」。
4. 選取「開啟」，然後按「OK」。

如需從視訊片段列印相片的資訊，請參閱從記憶卡列印相片。

使用創意
印表機提供多種工具與效果可讓您透過有創意的方式來處理您的相片。這些列印
設定不會變更原始相片。僅會影響列印。

增加色彩效果

您可以設定印表機，將套用到相片的色彩選項從「彩色」(預設值) 變更為「黑
白」、「褐色」或「古董色」。

以「褐色」效果列印的相片呈褐色色調，看起來像二十世紀初期拍攝的相片。以
「古董色」列印的相片呈現與褐色列印相同的褐色色調，但增加了一些灰白色，
給人的感覺就像是手工上色的。

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「精靈」，然後按「OK」。
3. 依照螢幕指示來選取紙張尺寸及相片，然後按「OK」。
4. 選取「完成選取」，然後按「OK」。
5. 選取「編輯相片」，然後按「OK」。
6. 選取「色彩效果」，然後按「OK」。
7. 選擇您想要的色彩效果，然後按「OK」。

在相片上增加日期和時間

您可以在相片正面列印戳記，顯示拍攝相片的時間。此偏好值將影響所有列印的
相片。

1. 選取「設定」，然後按「OK」。
2. 使用箭頭按鈕尋找並選取「偏好設定」，然後按「OK」。
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3. 選取「日期戳記」，然後按「OK」。
4. 選取下列其中一個日期/時間戳記選項：

– 日期和時間
– 日期
– 關閉

如果您用電腦修改相片，然後儲存變更，則最初的日期和時間資訊將會遺失。用
印表機控制台對相片所作的變更則不會影響日期和時間資訊。

變更列印品質

您可以變更相片的列印品質。「最佳」品質是預設設定，可印出品質最高的相
片。「一般」品質可節省墨水，並加快列印的速度。

變更列印品質：

1. 選取「設定」，然後按「OK」。
2. 選取「偏好設定」，然後按「OK」。
3. 選取「列印品質」，然後按「OK」。
4. 選取您想要的列印品質，然後按「OK」。

下一次列印工作完成後，品質將還原為 「最佳」。

裁剪相片

按「縮放 +」和「縮放 –」，按照 1.25x 的倍率增加或減少縮放倍數。倍數的
上限為 5.0x。
1. 選取「檢視與列印」，然後按「OK」。
2. 選取「4×6」，或選取「放大」以選擇您想要的相片尺寸，然後按「OK」。
3. 選取您想要的紙張尺寸，然後按「OK」。
4. 選取您想要的相片，然後按「OK」。
5. 按「縮放 +」，按照 1.25x 的倍率增加相片的縮放倍數。綠色裁剪方塊將會

出現。重複按「縮放 +」直到到達所要的放大倍數 (放大相片之後，您可以
透過按「縮放 –」將它縮小)。

附註 如果以選定的放大倍數列印會明顯降低列印品質，則裁剪方塊
會從綠色變成黃色。

6. 在任何放大倍數下，均可使用箭頭向上、下、左、右移動裁剪方塊。

7. 要列印的影像部份在裁剪方塊中時，按「OK」。
裁剪不會變更原始相片。僅會影響列印。

列印全景相片

1. 選取「檢視與列印」，然後按「OK」。
2. 選取「其他專案」，然後按「OK」。
3. 選取「全景列印」，然後按「OK」。
4. 依照提示放入 10 x 30 公分 (4 x 12 英吋) 材質，然後按「OK」。
5. 選取相片並按「OK」。如果需要的話，可在列印前裁剪相片。裁剪方塊具

有 3:1 的長寬比。
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附註 所有以全景模式列印的相片將列印為無邊框。
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4 連接

使用印表機連接到其他裝置，或與他人保持聯繫。

連接到其他裝置
此印表機提供數種方式連接到電腦或其他裝置。每一種連接方式可讓您執行不同
的作業。

連線類型與需要的配件 可讓您...

記憶卡

記憶卡

相容數位相機記憶卡

將記憶卡插入印表機前方的適當記憶
卡插槽中。

● 直接從記憶卡列印到印表機。
● 將插入到印表機之記憶卡上的相片

儲存到電腦，可以使用電腦上的
HP Photosmart Premier 或其他軟
體來增強或整理相片。如需詳細資
訊，請參閱將相片儲存到電腦和從
記憶卡列印相片。

USB
● 通用序列匯流排 (USB) 2.0 全速相

容纜線，長度不得超過 3 公尺 (10
英呎)。如需關於使用 USB 纜線連
接印表機的指示，請參閱「快速入
門」手冊。

● 可以存取網際網路的電腦 (使用
「HP Photosmart 共享」)。

● 從電腦列印到印表機。請參閱從電
腦列印。

● 將插入到印表機之記憶卡上的相片
儲存到電腦，可以使用電腦上的
HP Photosmart Premier 或其他軟
體來增強或整理相片。

● 透過「HP Photosmart 共享」共
享相片。

● 從 HP Photosmart 可直接列印的
數位相機直接列印到印表機。如需
詳細資訊，請參閱從數位相機列印
相片與相機的說明文件。

PictBridge

PictBridge 符號

直接從 PictBridge 相容數位相機列印
到印表機。

如需詳細資訊，請參閱從數位相機列
印相片與相機的說明文件。
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連線類型與需要的配件 可讓您...
PictBridge 相容數位相機與 USB 纜線。

將相機連接到印表機前方的相機埠。

Bluetooth
選購的 HP Bluetooth 無線印表機轉接
器。

如果印表機附帶此配件，或者您有個
別購買此配件，請參閱隨附的說明文
件及線上說明以獲取相關指示。

從具備 Bluetooth 無線技術的任何裝
置 (如數位相機、相機手機，或
PDA) 列印到印表機。

如果您在印表機的相機連接埠上連接
選購的 HP Bluetooth 無線印表機轉接
器，請確定已依需要設定了 Bluetooth
印表機功能選項。請參閱設定。

iPod
iPod 與隨附的 USB 纜線。將 iPod 連
接到印表機前方的相機連接埠。

直接從 iPod (有相片儲存在內) 列印到
印表機。如需詳細資訊，請參閱從
iPod 列印相片。
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將相片儲存到電腦
如果您已透過 USB 纜線連接印表機與電腦，則可將相片從插入印表機的記憶卡
儲存到電腦。

如果您使用 Windows 電腦

使用其中一種方法將相片儲存到電腦。

● 將記憶卡插入印表機。HP Photosmart Premier 傳輸軟體 (HP 傳輸與快速列
印) 會在電腦螢幕上開啟，並讓您指定要在電腦中儲存影像的位置。如需詳
細資訊，請參閱螢幕 HP Photosmart 軟體說明。

● 將記憶卡插入印表機。記憶卡在 Windows 檔案總管中顯示為卸除式磁碟
機。開啟卸除式磁碟機並將相片從記憶卡拖放到電腦中的任何位置。

如果您使用 Macintosh
1. 將記憶卡插入印表機。

2. 等待 iPhoto 開啟並讀取記憶卡上的內容。

附註 只有將 iPhoto 設定為預設的應用程式，它才會開啟。

3. 按一下「Import」(匯入) 將記憶卡上的相片儲存到 Macintosh。

附註 記憶卡也在桌面上顯示為一個磁碟機圖示。您可以開啟它並將相片
從記憶卡拖放到 Macintosh 中的任何位置。

透過「HP Photosmart 共享」連接
使用「HP Photosmart 共享」，您可以透過電子郵件、線上相簿或線上相片沖印
服務，與親朋好友分享相片。印表機必須透過 USB 纜線連接到可以存取網際網
路的電腦，並且電腦上必須已安裝全部 HP 軟體。如果您嘗試使用「共享」，但
是沒有安裝或設定所有必要的軟體，系統會顯示訊息提示您完成所有必要的步
驟。

使用「共享」(USB) 傳送相片 (Windows 使用者)：
1. 插入記憶卡並選取一些相片。

2. 選取印表機螢幕上的「共享」，然後按「OK」。
3. 依照電腦上的指示與其他人分享選定的相片。

使用「共享」(USB) 傳送相片 (Mac 使用者)
1. 開啟「HP Photosmart Studio」並選取要共享的相片。如需有關

HP Photosmart Studio 的詳細資訊，請參閱 HP Photosmart Premier
(Windows 使用者)。

2. 在 HP Photosmart Studio 工具列中，按一下「Share」(共享)。
3. 按一下「Continue」(繼續)，並且依照電腦上的指示，與其他人共享選取的

相片。

如需使用「HP Photosmart 共享」的詳細資訊，請參閱螢幕軟體說明。
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5 從電腦列印

若要從電腦列印，電腦中必須已安裝印表機軟體。安裝軟體期間，若電腦已安
裝 HP Photosmart Premier (Windows 完整安裝的使用者)、HP Photosmart
Essential (Windows 快速安裝的使用者) 或是 HP Photosmart Studio (Mac)，您
便能夠組織、共享、編輯以及列印相片。

如需安裝軟體的詳細資訊，請參閱「快速入門」。經常更新軟體可以確保您擁有
最新的改進功能；如需相關指示，請參閱更新軟體。

若要處理相片，您需要將它們傳輸到與印表機相接的電腦上。請參閱將相片儲存
到電腦。

附註 Windows 使用者：HP Photosmart Premier 僅可以在具備 Intel®
Pentium® III (或同等級) 以及更快處理器的電腦上使用。

使用印表機軟體中的創意選項
閱讀這些訣竅，以了解如何開啟與使用 HP Photosmart Premier、HP Photosmart
Essential、HP Photosmart Studio (Mac)，以及 HP Photosmart 共享。

HP Photosmart Premier (Windows 使用者)
HP Photosmart Premier 是一個易於使用的軟體程式，除了提供基本的相片編輯
與列印功能之外，還提供獲得相片樂趣所需的一切功能。此軟體也可讓您存取
「HP Photosmart 共享」，以供您輕鬆地共享相片。

開啟 HP Photosmart Premier
➔ 連按兩下桌面上的「HP Photosmart Premier」圖示。如果您需要協助，請

參閱 HP Photosmart Premier 中的軟體說明。

探究 HP Photosmart Premier 的多種功能：

● 檢視 — 以多種尺寸和方式檢視相片。輕鬆地整理和管理您的相片。
● 編輯 — 裁剪相片和消除相片的紅眼。自動以不同尺寸和多種版面調整和增

強相片。
● 列印 — 以不同尺寸和多種版面列印相片。
● 共享 — 使用「HP Photosmart 共享」將相片傳送給親朋好友，而不需要大

型附件，這是比傳送電子郵件更好的方式。
● 創意 — 輕鬆地製作相簿頁、卡片、日曆、全景相片、CD 標籤等。
● 備份 — 製作相片備份以供儲存。

HP Photosmart Essential (Windows 使用者)
HP Photosmart Essential 是一個易於使用的軟體程式，可提供基本的相片編輯
和列印功能。此軟體也可讓您存取 HP Photosmart 共享，以供您輕鬆地共享相
片。HP Photosmart Essential 僅為 Windows 使用者提供。
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開啟 HP Photosmart Essential
➔ 連按兩下桌面上的「HP Photosmart Essential」圖示。如果您需要協助，請

參閱 HP Photosmart Essential 中的軟體說明。

探究 HP Photosmart Essential 的多種功能：

● 檢視 — 以多種尺寸和方式檢視相片。輕鬆地整理和管理您的相片。
● 編輯 — 裁剪相片和消除相片紅眼。自動調整和增強相片讓相片更完美。
● 列印 — 以不同尺寸和多種版面列印相片。
● 共享 — 藉由「HP Photosmart 共享」將相片傳送給親朋好友，而不需要大

型附件，這是比傳送電子郵件更好的方式。

HP Photosmart Studio (Macintosh 使用者)
➔ 在 Dock 中按一下「HP Photosmart Studio」圖示。

探究 HP Photosmart Mac 軟體的多種功能 (可從 HP Photosmart Studio 存取)：
● Import (匯入) — 從 HP 數位相機匯入相片或視訊。
● View and Manage (檢視與管理) — 檢視、整理及管理您的相片及視訊。
● Edit (編輯) — 調整並增強影像。
● Slideshow (幻燈放映) — 為您的相片製作線上幻燈放映。
● Panorama (全景) — 將數個影像製作成單一全景影像。
● Create (創意) — 製作相簿頁、卡片、標籤、海報、橫幅等。
● Print (列印) — 以標準尺寸或以相片目錄格式，列印相片和視訊中的畫面。
● Share (共享) — 將相片傳送給親朋好友，而不需要使用大型附件。
● Shop (採購) — 訂購線上列印品及禮物。

HP Photosmart 共享

「HP Photosmart 共享」可讓您將相片傳送給親朋好友，而不需要大型附件。如
需詳細資訊，請參閱透過「HP Photosmart 共享」連接與 HP Photosmart
Premier 或 HP Photosmart Essential 的說明。

開啟 HP Photosmart 共享 (Windows 使用者)
➔ 按一下 HP Photosmart Premier 或 HP Photosmart Essential 中的「HP

Photosmart 共享」標籤。

開啟 HP Photosmart 共享 (Mac 使用者)
➔ 按一下 HP Photosmart Premier 中的「Applications」(應用程式) 標籤，然

後連按兩下「HP Photosmart Share」(HP Photosmart 共享)。

設定列印偏好值
列印偏好值是預設值，但也可以更改以符合您的需要。當您從電腦列印時，可以
設定特定的工作設定值。若您在列印前變更設定值，則該變更只會影響目前的列
印工作。在一些 Windows 軟體程式中，您必須按一下「列印」對話方塊中的
「內容」或「偏好值」，以存取進階列印功能。如需列印偏好值的詳細資訊，請
參閱電子版說明。
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存取列印偏好值 (Windows 使用者)
1. 開啟「列印」對話方塊，此操作通常透過在「檔案」功能表中選取 「列

印」執行。
2. 變更「列印」對話方塊標籤中的列印偏好值，或者按一下「內容」或 「偏

好值」存取更多列印偏好值。

存取列印偏好值 (Mac 使用者)
1. 開啟「列印」對話方塊，此操作通常透過在「檔案」功能表中選取 「列

印」執行。
2. 透過在「份數與頁數」下拉式功能表中選取您要變更的列印選項，來變更

「列印」對話方塊中的列印偏好值。

如需變更列印偏好值的詳細資訊，請參閱電子版說明。

開啟電子版說明

Windows 使用者：

● 按下鍵盤上的 F1。
● 如需欄位級別說明，請按一下「列印」對話方塊右上角的「?」。

Mac 使用者：

1. 請從「Finder」中選擇「輔助說明」 > 「Mac 輔助說明」。
2. 從「資料庫」功能表中選擇「HP Photosmart Mac Help」(HP Photosmart

Mac 輔助說明)，再從「HP Photosmart Mac Help」(HP Photosmart Mac
輔助說明) 目錄中選擇印表機名稱。

HP Real Life 技術功能
探究 HP Real Life 技術軟體功能中的眾多相片編輯和增強選項。這些功能，如
自動消除紅眼和適應照明，讓您更容易列印高品質的相片。

共有三個選項可供使用：

● 「基本」設定能使影像清晰，並改善低解析度影像 (如從網際網路下載的影
像) 的品質和清晰度。

● 「完整」設定能改善曝光不足或過度曝光、包含黑色區域或紅眼、或有看似
褪色色彩的影像。

● 「關閉」設定可讓您在軟體程式中 (例如 HP Photosmart 軟體) 手動編輯影
像。

存取 Real Life 技術功能 (Windows 使用者)
1. 開啟「列印」對話方塊，此操作通常透過在「檔案」功能表中選取 「列

印」執行。
2. 按一下「紙張/品質」標籤，然後按一下「Real Life 數位攝影」按鈕 —或者

— 按一下「內容」或「偏好值」按鈕，然後按一下「Real Life 數位攝影」
按鈕。
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存取 Real Life 技術功能 (Mac 使用者)
1. 開啟「列印」對話方塊，此操作通常透過在「檔案」功能表中選取 「列

印」執行。
2. 在「份數與頁數」下拉式功能表中，選取「Real Life Digital Photography」

(Real Life 數位攝影)。
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6 愛護與維護

本款印表機並不需要特別維護。只要遵守本節介紹的指引說明，就可以延長印表
機與列印耗材的使用期限，並確保最高品質的列印效果。

● 清潔及維護印表機
● 更新軟體
● 儲存及運送印表機和墨匣
● 維護相紙的品質

清潔及維護印表機
請使用本節說明的簡單程序，使印表機和列印墨匣常保清潔和最佳狀態。

清潔印表機外部

1. 關閉印表機的電源，然後拔掉接到印表機後方的電源線。

2. 使用稍微沾濕清水的軟布擦拭印表機外部。

注意 請勿使用任何種類的清潔劑，因為一般家用去污劑和清潔劑可能會
損壞印表機的表面塗漆。請勿清潔印表機的內部。切勿讓任何液體流入印
表機內部。請勿潤滑支撐列印頭滑動的金屬桿。列印頭前後滑動時產生噪
音屬於正常現象。

校正印表機

如果自我測試報告顯示色塊有線條或白色條紋，請使用下列程序。

如果校正印表機後仍然有列印品質問題，請嘗試使用愛護與維護中描述的程序來
清潔列印頭。若校正與清潔後，列印品質仍然有問題，請聯絡 HP 支援。

1. 將未使用的 Letter 或 A4 一般白紙放入主紙匣。
2. 選取「設定」，然後按「OK」。
3. 選取「工具」，然後按「OK」。
4. 捲動以找到並選取「校正印表機」。

印表機將會校正列印頭、列印校正頁，並校準印表機。請回收或丟棄校正
頁。

5. 按「OK」。

列印樣本頁

您可以列印樣本頁來測試印表機的相片列印品質，並確認紙張是否正確放入。

1. 在主紙匣中放入紙張。使用一般紙張可以節省相紙。

2. 選取「設定」，然後按「OK」。
3. 選取「工具」，然後按「OK」。
4. 選取「列印樣本頁」，然後按「OK」。
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自動清潔列印頭

如果您發覺列印的相片上或自我測試報告上的色塊中有白色線條或條紋，請使用
此程序清潔列印頭。若非必要，請勿清潔列印頭，因為這麼做會浪費墨水以及縮
短列印頭墨水噴嘴的使用壽命。

1. 在主紙匣中放入紙張。使用一般紙張可以節省相紙。

2. 選取「設定」，然後按「OK」。
3. 選取「工具」，然後按「OK」。
4. 選取「清潔列印頭」，然後按「OK」。

如果清潔列印頭之後，列印品質仍然不佳，請嘗試使用校正印表機中描述的程序
來校正印表機。若清潔與校正後，列印品質仍然有問題，請聯絡 HP 支援。

手動清潔墨匣的接點

如果印表機螢幕上出現訊息指明墨匣找不到或損壞，請清潔墨匣的銅色接點。

清潔墨匣的接點前，先取出墨匣並確認墨匣的接點或墨匣插槽沒有被任何東西覆
蓋，然後再重新安裝墨匣。如果您繼續收到一則訊息指明墨匣找不到或損壞，請
清潔墨匣的接點。如果清潔接點後仍然收到此訊息，您就必須更換墨匣。取出有
問題的墨匣，並查看底部 YYYY/MMM/DD (年/月/日) 格式的保固到期日。若仍
在保固期限內，請聯絡 HP 支援中心，以取得替換的墨水匣。

清潔墨匣的接點：

1. 請備齊下列物件來清潔接點：

– 蒸餾水、過濾水，或瓶裝水 (自來水中可能含有會損壞墨匣的物質)

注意 請勿使用平板玻璃清潔劑或酒精來清潔墨匣的接點。這會
損壞墨匣或 HP Photosmart。

– 使用不會分離或留下纖維的乾泡棉橡膠棒、無棉絮擦布，或任何柔軟的
材料。

2. 打開印表機頂蓋。

3. 緊壓墨匣插槽下面的灰色卡扣閂鎖以釋放印表機內部的灰色卡榫，然後提起
卡榫。

注意 請勿同時取出多個墨匣。一次只取出和清潔一個墨匣。切勿將
墨匣留在印表機外超過 30 分鐘。

4. 用清水稍微沾濕棉花棒或擦布，並擠出多餘的水份。

5. 握住墨匣的把手，用棉花棒或擦布輕輕擦拭銅色接點。
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1 輕輕擦拭銅色接點

6. 將墨匣放回空的插槽，然後將灰色閘鎖向下壓直到它卡入到位。

7. 依需要為其他墨匣重複上述步驟。

8. 合上頂蓋。

注意 墨匣內有壓力。在墨匣中插入異物將造成墨水溢出並接觸到人體或
物體。

列印自我測試報告

如果您遇到列印問題，請列印自我測試報告。此兩頁報告 (稱為擴充自我測試診
斷頁) 可以幫助您診斷列印問題，並在您需要致電 HP 支援時提供有用的資訊。
您也可以使用此報告來查看墨匣中剩餘的大約墨水存量。

1. 選取「設定」，然後按「OK」。
2. 選取「工具」，然後按「OK」，再捲動至列印測試頁。
3. 選取「列印測試頁」，然後按「OK」。

HP Photosmart 所列印的兩頁自我測試報告包含以下資訊：

● 產品資訊：包括機型號碼、序號，以及其他產品資訊。
● 版本資訊：包括韌體版本編號，並指明是否已安裝 HP 雙面列印配件 (雙面

列印器)。
● 供墨系統資訊：顯示每個已安裝墨匣的大約墨水存量、墨匣狀態、安裝日

期，以及有效使用期限。
● 列印頭組件資訊：包含在您需要致電 HP 支援時用於診斷目的的資訊。
● 列印頭參數：包含在您需要致電 HP 支援時用於診斷目的的資訊。
● 列印品質圖樣：顯示六個色塊，各代表六個已安裝的墨匣。當色塊出現條

紋，或遺失色塊，請使用愛護與維護中描述的程序來清潔列印頭。如果清潔
列印頭之後，色塊仍然顯示列印品質問題，請使用校正印表機中描述的程序
來校正印表機。若清潔與校正後，色塊仍顯示列印品質有問題，請聯絡
HP 支援。

● 歷史記錄：包含在您需要致電 HP 支援時用於診斷目的的資訊。
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自我測試報告

更新軟體
請定期下載最新的印表機軟體更新程式，以確保您擁有最新的改進功能。您可以
造訪 www.hp.com/support 或使用「HP 軟體更新程式」，下載印表機軟體的更
新程式。

附註 您從 HP 網站下載的印表機軟體更新程式無法更新 HP Photosmart
Premier 軟體。

下載軟體 (Windows)

附註 在使用「HP 軟體更新程式」之前，請確定已連線至網際網路。

1. 從 Windows「開始」功能表中，選取「程式集」 (在 Windows XP 中，選
取「所有程式」) > 「Hewlett-Packard」 > 「HP 軟體更新程式」。螢幕上
將會開啟「HP 軟體更新程式」視窗。

2. 按一下「立即檢查」。「HP 軟體更新程式」將會搜尋 HP 網站以進行印表
機軟體更新。如果電腦上沒有安裝最新版本的印表機軟體，「HP 軟體更新
程式」視窗中會顯示軟體的更新程式。

附註 如果電腦上已安裝最新版本的印表機軟體，「HP 軟體更新程
式」視窗中會顯示下列訊息：「此時沒有適用於您系統的更新程
式」。

3. 如果有軟體更新程式，請按一下軟體更新程式旁邊的核取方塊以選取它。

4. 按一下「安裝」。

5. 依照螢幕上的指示完成安裝。
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下載軟體 (Mac)

附註 在使用 HP Photosmart Updater (HP 更新程式) 之前，請確定已連
線至網際網路。

1. 在 Mac 的 Finder 中，選取「前往」>「應用程式」。
2. 選取 「Hewlett-Packard」 > 「Photosmart」 > 「HP Photosmart

Updater」(HP 更新程式)。
3. 依照電腦螢幕上的指示檢查軟體更新程式。

如果系統受防火牆的保護，您需要在更新工具中輸入代理伺服器資訊。

儲存及運送印表機和墨匣
印表機和墨匣不用時，請妥善儲存以保護它們。

儲存及運送印表機

此印表機能夠短時間或長時間放置不使用。請將印表機儲存在室內，遠離直射的
日光，並避免溫度過冷過熱。

注意 防止墨水遺失或溢出：請勿將印表機傾斜放置， 儲存及運送印表機
時請將墨匣留在印表機內裝好。

儲存及運送墨匣

儲存及運送印表機時，一定要將所用的列印墨匣留在印表機內，以免墨水乾掉。

注意 1 防止墨水遺失或溢出：儲存及運送印表機時，請將墨匣留在印表
機內，並且避免將用過的墨匣長時間留在印表機外面。

注意 2 請確定印表機在拔下電源線前已完成電源關閉程序。這樣可使印
表機正確地存放列印頭。

遵循以下訣竅將有助於維護 HP 墨匣，並確保一致的列印品質：

將所有還未使用的墨匣都儲存在原始的密封包裝盒中，直到要使用時再取出來。
請在室溫下保存墨匣 (攝氏 15–35 度或華氏 59–95 度)。

維護相紙的品質
為使相紙呈現最佳列印效果，請遵循這一節的指引說明。

儲存相紙

● 相紙應儲存在原始包裝袋或可重複密封的塑膠袋中。
● 封裝好的相紙應平放在乾燥涼爽處。
● 未使用的相紙應放回塑膠袋中。若將相紙留在印表機內，或暴露在空氣中，

相紙可能會開始捲曲。
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拿取相紙

● 拿取相紙時只能碰觸相紙邊緣，以免留下指紋。
● 如果相紙邊緣捲曲，請將相紙放回塑膠袋中，輕輕向捲曲相反的方向折彎，

直到紙張平整。

第 6 章

46 HP Photosmart D7100 series



7 疑難排解

HP Photosmart 印表機效能可靠，易於使用。本章回答有關使用印表機及不連接
電腦進行列印的常見問題，包含有關以下主題的資訊：

● 印表機硬體問題
● 列印問題
● 錯誤訊息

如需其他疑難排解資訊，請參閱：

● 軟體安裝疑難排解：印表機隨附的「快速入門指南」。
● 印表機軟體和從電腦列印之疑難排解：螢幕「HP Photosmart 印表機說

明」。如需檢視螢幕 HP Photosmart 印表機說明的詳細資訊，請參閱歡迎。

印表機硬體問題
在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

附註 如果您要利用 USB 纜線將印表機連接到電腦，HP 建議使用長度不
超過 3 公尺 (10 英呎) 的 2.0 高速相容纜線。

列印燈號呈藍色閃爍，但印表機不列印

解決方案 印表機正在處理資訊；請等到它完成。

注意燈號亮起

解決方案

● 查看印表機螢幕以取得相關指示。如果印表機有連接數位相機，請查看
相機螢幕以取得相關指示。如果印表機有連接電腦，請查看電腦顯示器
以取得相關指示。

● 關閉印表機，然後拔下電源線。等候大約 10 秒鐘，然後重新插上電源
線。開啟印表機。

如果嘗試以上解決方法後，注意燈號仍然一直亮起，請造訪 www.hp.com/
support，或聯絡 HP 支援以取得協助。

印表機找不到我儲存在記憶卡上的相片

解決方案 記憶卡所包含的檔案類型，可能不是印表機可以直接從記憶卡讀
取的類型。

● 將相片儲存到電腦，再從電腦列印相片。如需詳細資訊，請參閱螢幕 HP
Photosmart 說明和相機隨附的說明文件。

● 下一次拍照時，修改數位相機的設定，使相片儲存成印表機可以直接從
記憶卡讀取的檔案類型。如需支援的檔案格式清單，請參閱印表機規
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格。如需設定數位相機以將相片儲存為特定檔案格式的說明，請參閱相
機隨附的說明文件。

如果問題仍然存在，可能需要重新格式化記憶卡。

印表機已連接電源線，卻無法開啟

解決方案

● 印表機可能消耗太多電源。請拔掉印表機的電源線。等候大約 10 秒
鐘，再插回電源線，然後開啟印表機。

● 印表機可能插入已關閉電源的插線板。請先開啟插線板的電源，再開啟
印表機的電源。

● 電源線可能已經損壞。請確定電源線上的綠燈有亮起。

印表機在開啟電源時發出噪音，或靜置一陣子之後開始發出噪音

解決方案 當印表機靜置很長一段時間 (大約 2 個星期) 之後，或是停電又
恢復電力時，可能會發出噪音。這是正常作業。印表機正在執行自動維護程
序，以確保最佳品質的列印輸出。

印表機上的所有指示燈在閃爍

解決方案 印表機遇到硬體錯誤的問題，並且可能需要維修。請拔掉印表機
的電源線。等候大約 10 秒鐘，然後重新插上電源線。開啟印表機。如果指
示燈仍在閃爍，請造訪 www.hp.com/support，或聯絡 HP 支援以取得協助。

列印問題
在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

我從控制台列印時，印表機沒有列印無邊框相片

解決方案 在設定列印工作時，請確定已選取正確的版面。選取相片與紙張
尺寸時，影像矩形框必須完全填滿橘色，以表示無邊框列印。

列印速度非常慢

解決方案 可能是下列其中一種情況：1) 您可能正在列印包含高解析度的圖
形或相片的 PDF 或專案；2) 您可能為列印輸出選擇了最高的解析度。 列印
含有圖形或相片的大型複雜專案 (尤其是較高的解析度) 比列印純文字文件要
慢。
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紙張未從主紙匣正確送入印表機

解決方案

● 相紙匣中可能放入太多紙張。請取出一些紙張，再重新嘗試列印。
● 主紙匣可能並未完全向內推入。請將主紙匣完全向內推入。
● 紙張導板的調整可能不正確。請確定紙張寬度與紙張長度導板已靠緊紙

張的邊緣並且沒有使紙張彎曲。
● 兩張或多張紙可能黏在一起。請從主紙匣中取出紙張並將紙疊展成扇形

以分開紙張，然後重新放入紙張並再次嘗試列印。
● 如果紙張有皺摺或彎曲，請嘗試使用不同的紙張。
● 紙張可能太薄或太厚。請使用 HP 噴墨紙以得到最佳的列印效果。如需

詳細資訊，請參閱選擇適用的紙張。

列印頁從出紙匣中掉出

解決方案 列印時請務必將出紙匣延伸架拉出。

列印輸出皺摺或捲曲

解決方案 您正在列印的專案比一般專案耗用較多的墨水。請從電腦列印專
案，並使用印表機軟體降低墨水飽和度。如需詳細資訊，請參閱螢幕 HP
Photosmart 說明。

印出的文件歪斜，或沒有位於紙張的中央

解決方案

● 可能沒有正確地放入紙張。請重新放入紙張，確定紙張已按照正確的列
印方向放入主紙匣，並且紙張寬度導板與紙張長度導板緊靠紙張邊緣。
如需放入紙張的指示，請參閱放入紙張訣竅。

● 如果您使用了雙面列印配件，請嘗試將它取出，更換後方機門，然後再
次列印。

● 可能需要校正印表機。如需詳細資訊，請參閱校正印表機。

列印的色彩不太令人滿意

解決方案

● 其中一個彩色墨匣可能已用盡，造成在列印時用另一種顏色來取代。請
從「工具」功能選項檢視墨水存量圖示，檢查估計的墨水存量 (設定 >
工具 > 顯示墨水容量)。如果墨匣已空，則替換該墨匣。如需詳細資
訊，請參閱插入墨匣。

● 可能需要校正印表機。如需詳細資訊，請參閱校正印表機。
● 可能需要清潔列印頭。如需詳細資訊，請參閱愛護與維護。
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列印時印表機沒有出紙或卡紙

解決方案

● 需要檢查印表機。請查看印表機螢幕以取得相關指示。
● 電源可能關閉或連接不牢靠。請確定已開啟電源，而且電源線連接穩

固。
● 主紙匣或相片匣中可能沒有任何紙張。請檢查紙張是否正確放入。如需

放入紙張的指示，請參閱放入紙張訣竅。
● 若列印時出現卡紙，請嘗試下列步驟：

– 關閉印表機，然後從電源插座中拔下印表機的電源線。清除印表機
中所有可能阻塞進紙路徑的紙張。取下後方機門。輕輕地取出卡在
印表機中的紙張，然後重新裝上後方機門。如果無法從印表機背面
取出所有卡住的紙張，請嘗試透過打開位於頂蓋內部的卡紙門，取
出卡在印表機中間的紙張。如需清除卡紙的兩個位置之圖示，請參
閱紙張錯誤。當您完成清除卡紙後，插上印表機電源線然後開啟電
源，再重新嘗試列印。

– 如果列印標籤，請確定標籤紙通過印表機時標籤面沒有剝離。

印表機印出空白頁

解決方案

● 您可能已經開始列印，然後又取消該列印工作。
如果在開始列印前取消列印工作，印表機可能已經放入準備列印的紙
張。下一次列印時，印表機在開始新列印專案前會先送出空白頁。

● 具有大量資料的列印工作可能已傳送到印表機。
等待印表機維護列印頭後，再繼續列印。

印表機要求我列印校正頁

解決方案 印表機必須定期執行列印頭校正以維持最佳列印品質。

出現提示時，放入 Letter 或 A4 一般紙張。丟棄或回收校正頁。

相片沒有依預設列印設定來列印

解決方案 您可能已為選取的相片變更列印設定。您在個別相片上套用的列
印設定取代了預設列印設定。請取消選取相片，以放棄所有套用於該個別相
片的列印設定。如需詳細資訊，請參閱設定。

印表機準備列印時退出空白紙張

解決方案 日光直射可能影響自動紙張感應器的運作。請將印表機移到無日
光直射的地方。
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列印品質不佳

解決方案

● 其中一個彩色墨匣可能墨水量太低，造成在列印時用另一種顏色來取
代。從「工具」功能選項檢視墨水存量圖示，檢查估計的墨水存量 (設
定 > 工具 > 顯示墨水容量)。如果墨匣中的墨水不足，請將它更換。如
需詳細資訊，請參閱插入墨匣。

● 使用專為此印表機設計的相紙。為獲取最佳效果，請使用選擇適用的紙
張中建議的紙張。

● 您可能列印在紙張的錯誤面上。請確定以列印面朝下的方式放入紙張。
● 您可能在數位相機上選擇了低解析度設定。請減少影像的大小並嘗試再

次列印。為在以後獲得更好的效果，請將數位相機設定為較高的相片解
析度。

● 墨匣或列印頭可能有問題。請嘗試執行下列步驟：

– 一次取出一個墨匣，然後再重新插入以確定每個墨匣都正確安裝。
– 執行自動列印頭清潔程序。如需詳細資訊，請參閱愛護與維護。
– 校正印表機。如需詳細資訊，請參閱校正印表機。
– 嘗試以上的所有解決方法之後，如果列印品質問題仍然存在，請聯

絡 HP 支援。

相片未正確列印

解決方案

● 您可能沒有正確地放入相紙。請以列印面朝下的方式放入相紙。
● 相紙可能沒有正確地送入印表機。請嘗試執行下列步驟：

– 檢查是否卡紙。如需詳細資訊，請參閱紙張錯誤。
– 將相紙儘量往內插入相片匣。
– 一次只放入一張相紙。

在數位相機中標記要列印的相片沒有列印

解決方案 某些數位相機可以讓您標記相機內部記憶體和記憶卡上之相片以
進行列印。如果您在內部記憶體標記相片，然後將相片從相機的內部記憶體
移到記憶卡上，標記不會隨之轉移。請將相片從相機內部記憶體轉移到記憶
卡之後，再標記要列印的相片。

錯誤訊息
在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

在印表機螢幕上出現的錯誤訊息可以分為以下類型：

● 紙張錯誤
● 墨匣錯誤
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● 記憶卡錯誤
● 電腦列印錯誤

紙張錯誤

在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

錯誤訊息：卡紙。清除卡紙然後按下「OK」。

解決方案 關閉印表機，然後從電源插座中拔下印表機的電源線。清除印表
機中所有可能阻塞紙張路徑的紙張。卸下後方機門。輕輕地取出卡在印表機
中的紙張，然後重新裝上後方機門。

1 取下後方機門可以清除卡紙。

如果您無法從印表機後方取出所有卡住的紙張，請嘗試透過打開位於頂蓋內
部的卡紙門，取出卡在印表機中間的紙張。

1 打開卡紙門可以清除印表機中間的卡紙。

插上印表機電源線然後開啟電源。

錯誤訊息：紙張用完。放入紙張然後按「OK」。

解決方案 放入紙張，然後按「OK」以再次列印。如需放入紙張的指示，
請參閱放入紙張訣竅。
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錯誤訊息：不支援的材質尺寸。

解決方案 印表機無法使用紙匣中放入的紙張尺寸。按「OK」，然後放入
支援的紙張尺寸。如需支援的紙張尺寸清單，請參閱印表機規格。

錯誤訊息：自動紙張感應器失效。

解決方案 自動紙張感應器阻塞或損壞。嘗試將印表機移到不受日光直射的
地方，然後按「OK」並嘗試再次列印。如果此方法無效，請造訪
www.hp.com/support 或聯絡 HP 支援。

墨匣錯誤

在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

錯誤訊息：安裝了錯誤的墨匣

解決方案 在您第一次安裝與使用 HP Photosmart 印表機時，請確定安裝
印表機隨附的墨匣。這些墨匣中的墨水是特別配製與列印頭組件中的墨水混
合。

若要解決這個問題，請使用 HP Photosmart 印表機隨附的墨匣來更換有問
題的墨匣。

如需更換墨匣的詳細資訊，請參閱插入墨匣。

錯誤訊息：不正確的墨匣

解決方案 裝置起始化之後無法再使用指定的墨匣。為 HP Photosmart 更
換適當的墨匣。您可以在此印表機中使用的墨匣編號印在此印刷版指南的封
底頁面上。

如需更換墨匣的詳細資訊，請參閱插入墨匣。

錯誤訊息：請儘快更換墨匣

解決方案 指定的墨匣已空。

您也許可以用列印頭組件中剩餘的墨水，再繼續列印一段很短的時間。更換
指定的墨匣或按「OK」繼續。

如需更換墨匣的詳細資訊，請參閱插入墨匣。
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錯誤訊息：墨匣已空

解決方案 指定的墨匣已空，而且列印頭中沒有足夠的墨水可供一般的列印
或維修工作。使用新墨匣替換指定的墨匣。

● 如果黑色墨匣是空的，您可以透過選擇印表機螢幕提示的選項繼續以其
他彩色墨匣進行列印。

● 如果彩色墨匣是空的，您可以透過選擇印表機螢幕提示的選項繼續以黑
色墨匣進行列印。

取決於列印工作的狀態，您可以按「OK」繼續。如果 HP Photosmart 在列
印工作的中途，請按「取消」然後重新開始列印工作。

附註 文字與相片品質在使用所有墨匣列印時會有所不同。如果沒有
儘快更換空墨匣，所有列印作業將停止。

如需更換墨匣的詳細資訊，請參閱插入墨匣。

錯誤訊息：無法列印

解決方案 有關的墨匣已無墨水。

立即更換有關的墨匣以便您可以繼續列印。

HP Photosmart 在替換指定的墨匣前，無法繼續列印。所有列印作業將停
止。

如需更換墨匣的詳細資訊，請參閱插入墨匣。

錯誤訊息：墨匣問題

解決方案 有關的墨匣找不到或損壞。

立即更換指定的墨匣以便您可以繼續列印。如果 HP Photosmart 並沒有墨
匣遺失，可能必須清理墨匣接點。

如需更換墨匣的詳細資訊，請參閱插入墨匣。如需清潔墨匣接點的詳細資
訊，請參閱愛護與維護。

如果 HP Photosmart 印表機並沒有墨匣遺失，而您在清潔墨匣接點後仍然
收到此訊息，您就必須更換墨匣。取出有問題的墨匣，並查看底部 YYYY/
MMM/DD (年/月/日) 格式的保固到期日。若仍在保固期限內，請聯絡 HP 支
援，取得替換的墨水匣。

錯誤訊息：墨水使用期限即將到期。— 或者 — 墨匣已過期。

解決方案 每個墨匣都有使用期限。使用期限的目的在於保護列印系統，並
且確保墨水品質。當您收到墨水到期的訊息時，請移除墨匣並更換新墨匣，
再關閉訊息。您也可以藉由依照電腦螢幕上的指示，不需更換墨匣就可以繼
續列印。HP 建議您更換過期的墨匣。HP 無法保證過期墨匣的品質或可靠
性。因為使用過期墨水而導致裝置需要維修或修理，將不含在保固範圍內。
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如需更換墨匣的詳細資訊，請參閱插入墨匣。

錯誤訊息：非 HP 墨水

解決方案 更換指定的墨匣或按「OK」繼續。

HP 建議您使用原廠 HP 墨匣。原廠 HP 墨匣都使用 HP  印表機設計與測試
以讓您輕易獲得永遠傑出的效果。

附註 HP 無法保證非 HP 墨水的品質或可靠性。如果印表機因為使用
非 HP 墨水出問題或受損而必須進行的印表機維修或修理將不包括在
保固範圍內。

如果您肯定自己購買了原廠 HP 墨匣，請瀏覽：

www.hp.com/go/anticounterfeit

錯誤訊息：原有的 HP 墨水已經耗盡

解決方案 更換指定的墨匣或按「OK」繼續。

HP 建議您使用原廠 HP 墨匣。原廠 HP 墨匣是專為 HP 印表機設計，並通
過在 HP 印表機上的測試，可在多次使用後仍能產生精美的列印效果。

附註 HP 無法保證非 HP 墨水的品質或可靠性。因使用非 HP 墨水導
致印表機故障或損壞而引起的印表機服務或維修，不在保固範圍內。

如果您確定自己購買的是原廠 HP 墨匣，請瀏覽：

www.hp.com/go/anticounterfeit

錯誤訊息：既定的維護程序

解決方案 您必須校正印表機以確保絕佳的列印品質。在主紙匣中放入未用
過的 Letter 或 A4 一般白紙，按「OK」。HP Photosmart 將校正列印頭，
校準印表機，然後列印測試頁。回收或丟棄測試頁。

錯誤訊息：校準錯誤

解決方案

● 如果校正印表機時主紙匣放入彩色紙張或相紙，校正可能會失敗。將未
用過的 Letter 或 A4 一般白紙放入主紙匣，然後嘗試再次校正。如果校
正再次失敗，可能是感應器或墨匣已損壞；請聯絡 HP 支援。

● 墨匣或感應器損壞。請聯絡 HP 支援。

錯誤訊息：列印墨匣托架被卡住

解決方案 取出阻塞列印頭組件的任何物件。
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清潔列印頭組件

1. 打開頂蓋，然後再打開卡紙門。

1 打開卡紙門可以清潔列印頭組件。

2. 取出阻塞列印頭組件的任何物件，包括紙張和任何包裝材料。

3. 關閉印表機的電源，然後再次開啟電源。

4. 關閉卡紙門和頂蓋。

錯誤訊息：墨水系統故障

解決方案 列印頭零件或墨水傳送系統已經失效，同時 HP Photosmart 無
法再列印。

關閉印表機，然後拔下電源線。等候大約 10 秒鐘，然後重新插上電源線。
如果此方法無法清除錯誤訊息，請聯絡 HP 支援。

記憶卡錯誤

在聯絡 HP 支援中心之前，請先閱讀本節內容以取得疑難排解訣竅，或瀏覽
www.hp.com/support 尋求線上支援服務。

錯誤訊息：找不到相片。—或者— 某些相片找不到。

解決方案 印表機無法讀取記憶卡上的檔案，或者，為該作業指定的一個或
多個檔案不在記憶卡上。嘗試使用數位相機而不是記憶卡將相片儲存到電腦
中。如果是缺失相片，可能是您意外將相片從記憶卡刪除。
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錯誤訊息：卡片存取錯誤。工作已取消。按下「OK」。— 或者 — 檔案目錄結構受損。

— 或者 — 卡片可能受損。工作已取消。按「OK」。

解決方案 印表機無法讀取記憶卡上的資料，無法完成目前的列印工作。資
料已損毀或記憶卡實體存在問題。

● 將檔案儲存至電腦，並從電腦存取。
● 若此方法無效，請使用新記憶卡或者使用數位相機重新格式化記憶卡。

記憶卡上的所有相片都將丟失。
● 如果此方法無效，則相片檔案或許已損毀或無法讀取。在聯絡 HP 支援

之前，請嘗試使用其他記憶卡來判斷是印表機還是記憶卡發生故障。

錯誤訊息：無法列印相片。

解決方案 列印工作指定的相片有超過 10 張以上可能已損壞、找不到或是
屬於不支援的檔案類型。如需支援的檔案類型之詳細資訊，請參閱印表機規
格。

● 使用數位相機而不是記憶卡將相片儲存到電腦中。
● 將檔案儲存至電腦，然後從電腦列印。
● 列印相片索引，然後重新選取相片。如需詳細資訊，請參閱列印相片。

錯誤訊息：卡片受密碼保護。無法存取卡片。

解決方案 插入的記憶卡受密碼保護，因此印表機無法讀取。請遵循下列步
驟：

1. 從印表機中取出記憶卡。

2. 將記憶卡插入在原先將密碼儲存在記憶卡的裝置內。

3. 刪除記憶卡的密碼。

4. 取出記憶卡並將其重新插入印表機的記憶卡插槽。

5. 嘗試再次列印。

錯誤訊息：卡片被鎖定。無法存取卡片。

解決方案 確定記憶卡上的鎖定開關處於解鎖的位置。

錯誤訊息：卡片並未完全插入。將卡片往內推一點。

解決方案 印表機可以偵測到記憶卡但無法讀取。輕輕將記憶卡推入記憶卡
插槽，直到卡停止移動。如需詳細資訊，請參閱插入記憶卡。
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錯誤訊息：一次僅能使用一張卡片。請取出一張記憶卡。—或者— 一次只能使用一部裝

置。請卸下/ 斷開裝置。

解決方案 印表機中同時插有兩種或更多不同類型的記憶卡，或者插入記憶
卡的同時有數位相機連接到相機連接埠。取出記憶卡或斷開相機，直到印表
機中只剩一張卡或僅連接一台相機為止。

錯誤訊息：卡片已移除。工作已取消。按「OK」。

解決方案 當印表機正從記憶卡列印檔案時，您從印表機中取出了記憶卡。
請遵循下列步驟：

1. 按「OK」。
2. 重新插入記憶卡，然後再次列印選定的相片。記憶卡必須在完成列印工

作前保持插入狀態。

若要避免日後損壞記憶卡，在存取記憶卡時，請勿從印表機記憶卡插槽中將
記憶卡取出。如需詳細資訊，請參閱取出記憶卡。

錯誤訊息：相機選擇的 (DPOF) 檔案有錯誤。

解決方案 由於資料損毀或記憶卡發生錯誤，印表機無法讀取 DPOF 檔
案。請使用印表機控制台重新選取相片。如需詳細資訊，請參閱從記憶卡列
印相片。

錯誤訊息：某些相機選擇的相片不在卡片中。

解決方案 某些相機選擇的相片找不到或者已刪除。請嘗試執行下列步驟：

● 確認您並未從記憶卡意外地刪除相片。
● 使用數位相機再次重新選取相片。
● 列印新的相片索引，以查看與每張相片相關的索引編號。如需詳細資

訊，請參閱列印相片。

錯誤訊息：無法顯示這張相片。—或者— 無法顯示所有相片。—或者— 相片已損毀。

解決方案 記憶卡上包含印表機不支援的影像格式，或者檔案已經損毀。如
需支援的影像格式清單，請參閱印表機規格。使用電腦存取相片。如需透過
電腦存取相片的詳細資訊，請參閱從電腦列印。

錯誤訊息：不支援的卡片類型。

解決方案 使用相機將相片傳輸到電腦，然後從電腦列印。
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錯誤訊息：某些相片號碼不在卡片中。

解決方案 使用相機將相片傳輸到電腦，然後從電腦列印。如果某些相片仍
然找不到，它們可能已從記憶卡中刪除。

電腦和連線列印錯誤

在聯絡 HP 支援之前，請先閱讀本節以獲取疑難排解訣竅，或造訪
www.hp.com/support 尋求線上支援服務。

錯誤訊息：印表機記憶體已滿。工作被取消。按下「OK」。

解決方案 印表機在列印相片時遇到問題。請嘗試執行下列步驟：

● 若要清除印表機記憶體，請關閉印表機，然後再次開啟。
● 一次列印較少的相片。
● 將相片儲存至電腦，並從電腦列印。
● 使用讀卡機將檔案儲存到電腦，然後從電腦列印。

錯誤訊息：通訊錯誤。檢查電腦連線。按下「OK」。—或者— 沒有收到資料。檢查電腦

連線。按下「OK」以繼續。—或者— 電腦沒有回應。

解決方案 電腦無法與印表機進行正常通訊。可能是印表機軟體無法操作或
者纜線鬆脫。確定 USB 纜線已穩固地連接至電腦及印表機背面的 USB 埠
上。如果纜線連接穩固，請驗證是否已安裝印表機軟體。

錯誤訊息：相機在列印工作過程中斷開。

解決方案 列印工作將被取消。將 USB 纜線重新連接到相機和印表機，並
重新傳送列印工作。
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8 HP 支援中心

支援程序

如果您遇到問題，請執行下列步驟：

1. 檢查 HP Photosmart 隨附的說明文件。
2. 造訪 HP 線上支援網站：www.hp.com/support。所有的 HP 客戶都可獲得

HP 線上支援。線上支援是取得最新裝置資訊和專家協助的最快捷方式，其
中包括：

– 快速連絡合格的線上支援人員
– HP Photosmart 的軟體與驅動程式更新程式
– 實用的 HP Photosmart 資訊與常見問題疑難排解資訊
– 註冊 HP Photosmart 後，即可自動取得該裝置的更新程式、支援通知

及 HP 新聞簡訊
3. 僅適用於歐洲地區：請聯絡您購買產品的經銷商。如果 HP Photosmart 有

硬體故障，可能會要求您將該裝置送回當地的經銷商處 (在裝置的有限保固
期內，提供免費維修服務；保固期限過後，您需要支付維修費用)。

4. 致電 HP 支援中心。支援選項和可用性會因裝置、國家/地區和語言而異。

致電 HP 支援中心
如需支援電話號碼清單，請參閱封面內的電話號碼清單。

電話支援期限

北美洲、亞太地區及拉丁美洲 (包括墨西哥) 可獲得一年的電話支援。若要確定
歐洲、中東及非洲的電話支援期限，請瀏覽 www.hp.com/support。您需支付標
準電話費用。

致電

請使用電腦與 HP Photosmart 旁邊的電話致電 HP 支援中心。請準備好提供以
下資訊：

● 裝置型號 (位於裝置正面的標籤上)
● 裝置序號 (位於裝置的背面或底部)
● 狀況發生時所顯示的訊息
● 下列問題的答案：

– 之前是否發生過此狀況？
– 您是否可以再現此狀況？
– 問題發生前後，您是否在電腦上新增任何新硬體或軟體？
– 在此問題出現之前是否發生過其他任何狀況 (如打雷、移動裝置等)？
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電話支援期限過後

電話支援期限過後，HP 提供的支援服務將酌情收費。您也可以在 HP 線上支援
網站取得說明：www.hp.com/support。請聯絡 HP 經銷商或致電您所在國家/地
區的支援中心，以了解關於支援選項的詳細資訊。
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A 規格

這一節列出安裝 HP Photosmart 軟體的最低系統需求，並提供此印表機的規格。

如需印表機規格及系統需求的完整清單，請參閱螢幕「HP Photosmart 印表機說明」。

如需檢視 HP Photosmart 螢幕說明的詳細資訊，請參閱歡迎。

系統需求

元件 Windows PC 最低需求 Macintosh 最低需求

作業系統 Microsoft® Windows 98、
2000 Professional、ME、
XP Home 與 XP
Professional

Mac® OS X 10.3、10.4 及
更新版本

處理器 Intel® Pentium® II (或同等

級) 或更快的處理器

G3、G4、G5 或 Intel Core
Duo 或更高版本

RAM 64 MB (建議 128 MB) Mac OS X 10.3、10.4 及更

新版本：128 MB

可用磁碟空間 500 MB 150 MB

視訊顯示器 800 x 600，16 位元或更高 800 x 600，16 位元或更高

CD-ROM 光碟機 4x 4x

連線 USB：Microsoft Windows
98、2000 Professional、
ME、XP Home 與 XP
Professional
PictBridge：使用前方的相
機連接埠

Bluetooth：使用選購的

HP Bluetooth 無線轉接器

USB：前方連接埠和後方連

接埠 (Mac OS X 10.3、
10.4 及更新版本)
PictBridge：使用前方的相
機連接埠

Bluetooth：使用選購的

HP Bluetooth 無線轉接器

瀏覽器 Microsoft Internet Explorer
5.5 或更新版本

—

印表機規格

類別 規格

連線 USB：Microsoft Windows 98、2000 Professional、
Me、XP Home 與 XP Professional；Mac OS X
10.3、10.4 及更新版本

影像檔案格式 JPEG 基準
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類別 規格

TIFF 24 位元 RGB 未壓縮的交換格式

TIFF 24 位元 YCbCr 未壓縮的交換格式

TIFF 24 位元 RGB 封包位元交換格式

TIFF 8 位元灰階未壓縮/封包位元

TIFF 8 位元調色盤彩色、未壓縮/封包位元

TIFF 1 位元未壓縮/封包位元/1D Huffman

視訊檔案格式 Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

材質規格 建議的最大長度：61 公分 (24 英吋)
建議的最大紙張厚度：292 微米 (千分之 11.5 英吋)
建議的最大信封厚度：673 微米 (千分之 26.5 英吋)

支援的材質尺寸 從電腦列印時的支援尺寸

7.6 x 12.7 公分到 22 x 61 公分 (3 x 5 英吋到 8.5 x 24
英吋)
從控制台列印時的支援尺寸

公制：A6、A4、10 x 15 公分 (含標籤或不含標籤)；
英制：3.5 x 5 英吋、4 x 6 英吋 (含標籤或不含標

籤)，4 x 12 英吋、5 x 7 英吋、8 x 10 英吋、8.5 x 11
英吋；其他：Hagaki 和 L 尺寸

支援的材質類型 紙張 (一般紙張、噴墨紙、相紙以及全景相片)
信封

投影片

標籤紙

卡片：索引卡、賀卡、Hagaki 卡、A6 卡、L 尺寸卡

轉印紙

Avery C6611 和 C6612 相片貼紙：10 x 15 公分 (4 x 6
英吋)，每頁具有 16 張方形或橢圓形貼紙

記憶卡 CompactFlash I 和 II 型
Microdrive
MultiMediaCard
Secure Digital
Memory Sticks
xD-Picture Card

記憶卡支援的影像檔案格式 列印：請參閱此表格中的影像檔案格式部份。

儲存：所有檔案格式

附錄 A
（續）
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類別 規格

紙匣 – 支援的材質尺寸 主紙匣

8 x 13 公分到 22 x 61 公分 (3 x 5 英吋到 8.5 x 24 英
吋)
相片匣

最大 10 x 15 公分 (4 x 6 英吋)，含標籤或不含標籤

出紙匣

皆可支援主紙匣和相片匣尺寸

紙匣容量 主紙匣

100 張一般紙張

14 張信封

20 - 40 張卡片 (取決於卡片的厚度)
30 張標籤紙

25 張投影片、轉印紙或相紙

10 張相紙

相片匣

出紙匣

20 張相紙

50 張一般紙張

10 張卡片或信封

25 張標籤紙或轉印紙

作業環境 建議的溫度範圍：攝氏 15-30 度 (華氏 59-86 度)
最大溫度範圍：攝氏 5-40 度 (華氏 41-104 度)
儲存溫度範圍：攝氏 -40-60 度 (華氏 -40-140 度)
建議的濕度範圍：20-80% 相對濕度

最大濕度範圍：10-80% 相對濕度

物理規格 高度：17.9 公分 (6.8 英吋)。
寬度：46.25 公分 (18.2 英吋)
深度：38.7 公分 (15.25 英吋)
重量：7.7 公斤 (17.0 磅)。

耗電量 列印，平均：75 W
列印，最大：94 W
閒置：13.3-16.6 W

電源供應器型號 HP 零件編號 0957-2105

電源要求 100–240 VAC (± 10%)、50–60 Hz (± 3 Hz)

墨匣 HP 黃色墨匣

（續）
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類別 規格

HP 青藍色墨匣

HP 淡青藍色墨匣

HP 洋紅色墨匣

HP 淡洋紅色墨匣

HP 黑色墨匣

附註 您可以在此印表機中使用的墨匣編號印
在此印刷版指南的封底頁面上。如果您已多次
使用此印表機，您應該也可以在印表機軟體中
找到墨匣編號。如需詳細資訊，請參閱插入墨
匣。

列印速度 (最大) 黑色列印輸出：每分鐘 32 頁
彩色列印輸出：每分鐘 31 頁
相片：每張 10 x 15 公分 (4 x 6 英吋) 相片 14 秒

USB 支援 Microsoft Windows 98、2000 Professional、ME、
XP Home 與 XP Professional
Mac OS X 10.3、10.4 及更新版本

HP 建議使用長度不超過 3 公尺 (10 英呎) 的 USB 2.0
全速相容纜線。

附錄 A
（續）
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B HP 保固
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1 Welcome
Thank you for purchasing an HP Photosmart D7100 series printer! With this new photo
printer you can print beautiful photos, save photos to a computer, and create fun and
easy projects with or without a computer.
This guide primarily explains how to print without connecting a computer. To learn how
to print from a computer, install the printer software and view the electronic Help. For an
overview of using a computer and the printer together, see Printing from a computer. For
information about installing the software, see the Quick Start guide.
Home users can learn how to:
● Print borderless photos from the printer or from a computer
● Choose a photo layout
● Convert a color photo to black and white, or apply a color effect such as Sepia or

Antique
The printer comes with the following documentation:
● Quick Start Guide: The  Quick Start Guide explains how to set up the printer, install

the printer software, and print your first photo.
● User Guide: The User Guide is the book you are reading. This guide describes the

basic features of the printer, explains how to use the printer without connecting a
computer, and contains hardware troubleshooting information.

● Onscreen help: The onscreen HP Photosmart printer help describes how to use
the printer with a computer and contains software troubleshooting information.

Special features
New features and media make it easier than ever to produce high-quality photos:
● When you use the new HP Advanced Photo Paper (also called HP Photo Paper in

some countries/regions), special sensors in the printer detect a mark on the back of
the paper and automatically select the optimal print settings. For more information
about this new paper, see Choose the right paper.

● HP Real Life technologies make it easy for you to get better photos. Automatic red
eye removal and adaptive lighting to enhance detail in shadows are just a few of the
many technologies included. You can explore the many editing and enhancing
options from both the control panel and from the printer software. To access these
features from the control panel, see Improving photo quality. To learn how to find
them in the software, see HP Real Life technologies features.

Accessing the onscreen HP Photosmart printer help
After you have installed the HP Photosmart printer software on a computer, you can view
the onscreen HP Photosmart printer help:
● Windows PC: From the Start menu, select Programs (in Windows XP, select All

Programs) > HP > HP Photosmart D7100 series > Photosmart Help.
● Macintosh: From the Finder Help menu, choose Mac Help. From the Help

Viewer Library menu, choose HP Photosmart Mac Help.
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Printer parts

Front of printer
1 On: Press this button to turn on the printer.
2 Top cover: Lift this cover to access the ink cartridges and to clear paper jams. To lift the cover,

grasp the top cover below the HP logo and pull upward.
3 Printer Screen: Use this screen to view photos, menus, and messages.
4 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
5 Main tray: Pull out this tray and load paper, transparencies, envelopes, or other media with

the side to be printed facing down.
6 Photo tray: Lift the output tray, pull out this tray, and load small-size paper up to 10 x 15 cm

(4 x 6 inch) into the photo tray for printing with the side to be printed facing down. The paper
may be tabbed or untabbed.

7 Memory card slots: Insert memory cards here. For a list of supported memory cards, see
Insert memory cards.

8 Camera port: Connect a PictBridge™ digital camera, the optional HP Bluetooth® wireless
printer adapter, or an iPod.

Back of printer
1 Power cord connection: Use this port to connect the power cord included with the printer.
2 USB port: Use this port to connect the printer to a computer.
3 Rear access door: Remove this door to clear paper jams or to install the optional

HP Automatic Two-sided Printing Accessory. See Optional accessories.

Chapter 1
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Main and Output trays
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the main tray.
2 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
3 Output tray extender: Pull towards you to extend the output tray to catch your printouts.
4 Main tray: Pull out this tray and load plain paper, transparencies, envelopes, or other media

with the side to be printed facing down.
5 Main tray grip: Pull toward you to extend the Main tray.
6 Paper-length guide: Adjust this guide to fit close to the end of the paper in the main tray.

Photo tray
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the photo tray.
2 Paper-length guide: Adjust this guide to fit close to the end of the paper in the photo tray.
3 Photo tray grip: Pull toward you to extend the photo tray.
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Control panel
1 On: Turn on the printer or put it into power save mode.
2 Back: Step back one screen at a time.
3 Home: Press to return to the home screen.
4 Navigation arrows: Adjust the crop box, navigate menu choices, and control the playback

of a video clip.
5 OK: Select a highlighted item, menu or dialog choice, and play/pause a video clip during

playback.
6 Print Preview: View a preview of the selected photo or photos.
7 Print: Print the selected photos from the inserted memory card, or from a camera connected

to the front camera port.
8 Cancel: Stops a print job.
9 Rotate: Rotate a photo or a crop box.
10 Zoom (+)(-): Zoom in or out of a photo or crop box. You can also press Zoom (-) to view

photos four at a time when viewing a photo at normal magnification.
11 Photo Fix: Automatically enhances and applies lighting, contrast, focus and red eye removal

features to all printed photos.

Indicator lights
1 On light: Solid blue if the printer is on, otherwise it is off.
2 Attention light: Flashes when there is an error condition. See the printer screen for

instructions or information about the error. For more information, see The Attention light is
on.

3 Print light: Solid blue when the printer is on and ready to print, flashes blue when the printer
is printing or busy with self-maintenance.

4 Photo Fix light: Solid blue when the Photo Fix function is turned on.
5 Memory Card light: Solid blue if a memory card is inserted, flashes if the printer is accessing

a memory card, off if no memory card is inserted or if more than one card is inserted. See the
printer screen for instructions.
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Optional accessories
There are several optional accessories available for the printer that enhance its portability
for printing anywhere, anytime. The appearance of the accessories may vary from what
is shown.
To purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/go/supplies (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)

Accessory name Description

HP Automatic Two-sided Printing
Accessory

This accessory automatically flips each
page to print on both sides. You will save
money (two-sided printing reduces paper
consumption) and time (no need to
remove the paper and reinsert it to print on
the back), plus you will make bulky
documents more manageable.
This accessory may not be available in all
countries/regions.

HP Bluetooth® wireless printer
adapter
1 Insert the Bluetooth adapter into the

front camera port

The HP Bluetooth® wireless printer
adapter goes into the camera port on the
front of the printer. This adapter lets you
use Bluetooth wireless technology for
printing from many Bluetooth-enabled
devices, including digital cameras,
camera phones, and PDAs.
For more information on printing with this
accessory, go to www.hp.com/go/
bluetooth.

Printer menu
Press the home button to access the home screen. You can access all of the functions
from the home screen as well as setup menus.
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View & Print
Wizard: Use the wizard to guide you through the printing process. Also use the wizard
to improve photo quality and apply advanced photo effects such as brightness and color
effects.
4×6: Use to print 4×6 inch (10 × 15 cm) photographs.
Enlargement: Use Enlargement to print different photo sizes.
Print All: Select to print all the photos from the memory card inserted in the printer.
Other Print Projects: Use Other Projects to print panoramic, HP CD/DVD Tattoos, wallet
prints, and passport photos.
– Panorama Prints: Select to turn panoramic printing On or Off (default). Select

On to print all selected photos with a 3:1 aspect ratio; load 10 x 30 cm (4 x 12 inch)
paper before printing.

– HP CD/DVD Tattoos: Select to print labels for CD/DVDs.
– Wallet Prints: Use to print wallet-sized photos.
– Passport Photos: Select to print a passport photo.

Save
Select Save to save selected images to a connected PC.

Share
Use Share to select and share photos through HP Photosmart Share.

Settings
● Tools: Use tools to display the ink gauge, adjust the print quality, print a sample

page, print a test page, and to clean and align cartridges.
– Display Ink Gauge: Use to enable an ink supply gauge on the home screen.
– Print sample page: Select to print a sample page, which is useful for checking

the print quality of the printer. This feature is not available in all printer models.
– Print test page: Select to print a test page containing information about the

printer that can help in troubleshooting problems.
– Clean Printhead: Select to clean the print head when white lines or streaks

appear in your printouts. After the cleaning finishes, the printer prints a self test
report. You have the option to clean the print head again if the report shows
print quality problems.

– Align printer: Select to align the printer when white lines or streaks appear in
your printouts.

● Bluetooth
– Device address: Some devices with Bluetooth wireless technology require you

to enter the address of the device they are trying to locate. This menu option
shows the printer address.

– Device name: You can select a name for the printer that appears on other
devices with Bluetooth wireless technology when they locate the printer.

– Passkey: When the Bluetooth Security level of the printer is set to High, you
must enter a passkey to make the printer available to other Bluetooth devices.
The default passkey is 0000.

– Visibility: Select Visible to all (default) or Not visible. When Visibility is set
to Not visible, only devices that know the printer address can print to it.
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– Security level: Select Low (default) or High. The Low setting does not require
users of other devices with Bluetooth wireless technology to enter the printer
passkey. High requires users of other devices with Bluetooth wireless
technology to enter the printer passkey.

– Reset Bluetooth options: Select to reset all items in the Bluetooth menu to
their default values.

● Help Menu: Use the help menu for instructions about using the printer.
– Cartridges: Select to see an animation of how to install an ink cartridge.
– Main Tray Loading: Select to read main tray paper loading instructions.
– Photo Tray Loading: Select to read photo tray paper loading instructions.
– Paper jams: Select to see an animation of how to clear a paper jam.
– Camera connect: Select to read instructions on how to connect a PictBridge

camera to the printer.
● Preferences

– 4 × 6 print paper size: Choose Ask before print to select the paper type and
size each time you print (default).

– Print quality: Choose either Best (default) or Normal print quality.
– Paper Type: Select Automatic (default) and the printer automatically detects

the paper type and size.
– Date Stamp: Use this option to include the date and/or time on your printed

photos.
– Colorspace: Choose a colorspace. The Auto-select default tells the printer to

use the Adobe RGB colorspace, if available. The printer defaults to sRGB if
Adobe RGB is not available.

– PictBridge Tray Select: Use to select the default paper tray for printing through
the PictBridge connection.

– Video enhancement: Select On (default) or Off. When you select On, the
quality of photos printed from video clips is improved.

– Restore Factory Defaults: Restores factory settings for all menu items
except Select language and Select country/region (under Language in
Preference menu) and Bluetooth settings (under Bluetooth in the main printer
menu). This setting does not affect HP Instant Share or Network defaults.
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2 Get ready to print
This section includes the following topics:
● Load paper
● Insert ink cartridges
● Insert memory cards

Load paper
Learn how to choose the right paper for your print job and how to load it into the input
tray for printing.

Choose the right paper
Use HP Advanced Photo Paper. It is especially designed to work with the inks in your
printer to create beautiful photos.
For a list of available HP-designed photo paper, or to purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/eur/hpoptions (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)
The printer is set by default to print the best quality photos on HP Advanced Photo Paper.
If you print on a different type of paper, be sure to change the paper type from the printer
menu. See Printer menu.

Paper loading tips
Paper loading tips:
● Load paper with the side to be printed facing down.
● You can print photos and documents on a wide variety of paper sizes, from 8 x 13 cm

(3 x 5 inch) up to 22 x 61 cm (8.5 x 24 inch). The 10 x 15 cm (4 x 6 inch) photo paper
is available with and without tabs.

● Before loading paper, pull the out main paper tray and slide out the paper-width and
paper-length guides to make room for the paper. After loading paper, adjust the
guides to fit close to the edges of the paper without bending the paper. When finished
loading paper, push the main tray back in all the way.

● Load only one type and size of paper at a time in the same tray.
● After loading paper, extend the output tray extension and raise the backstop to catch

your printed pages.

Load the main tray
Any supported photo or plain paper media
1. Extend the main tray.
2. Slide the paper-width and paper-length guides to their outermost positions.
3. Load paper with the side to be printed facing down. Make sure the stack of paper

fits loosely under the tab on the paper-length guide.
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1 Paper-width guide
2 Paper-length guide

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper.

5. Push the main tray all the way in.

1 Push in the main tray all the way

Load the photo tray
Use photo paper up to 10 x 15 cm (4 x 6 inch) with or without tabs, Hagaki cards, A6
cards, and L-size cards.
1. Lift the output tray and extend the photo tray.
2. Adjust the paper-width and paper-length guides outward to make room for the paper.

1 Output tray
2 Paper-width guide
3 Paper-length guide

3. Load up to 20 sheets of paper into the photo tray with the print side down. If you are
using tabbed paper, insert the paper so the tab is closer to you.

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper. Make sure the stack of paper fits loosely under the tab on the paper-
length guide.

5. Push in the photo tray.
6. Close the output tray.
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1 Paper-width guide
2 Paper-length guide
3 Photo tray grip.

Insert ink cartridges
The first time you set up and use your HP Photosmart printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink cartridges is
specially formulated to mix with the ink in the print head assembly.

Purchasing replacement ink cartridges
When purchasing replacement cartridges, refer to the cartridge numbers that appear on
the back cover of this guide. These cartridge numbers may vary by country/region.

Note If you have already used the printer several times and you have installed
the HP Photosmart printer software, you can also find the cartridge numbers in
the printer software. Windows users: Right-click the HP Digital Imaging Monitor
icon in the Windows taskbar, and select Launch/Show HP Solution Center.
Select Settings, then Print Settings, and then Printer Toolbox. Click the
Estimated Ink Levels tab, and then click Ink Cartridge Information. To order
ink cartridges, click Shop Online. Mac users: Click HP Photosmart Studio in
the Dock. In the HP Photosmart Studio toolbar, click Devices. From the
Information and Settings pop-up menu, choose Maintain Printer and then
click Launch Utility. In the Configuration Settings list, click Supply Info.
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Ink cartridge tips
HP Vivera Inks deliver true-to-life photo quality and exceptional fade resistance resulting
in vivid colors that last for generations! HP Vivera Inks are specially-formulated and
scientifically tested for quality, purity and fade resistance.
For best print quality, HP recommends that you install all retail ink cartridges before the
install-by date stamped on the box.
For optimum printing results, HP recommends using only genuine HP ink cartridges.
Genuine HP ink cartridges are designed and tested with HP printers to help you easily
produce great results, time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer service
or repairs required as a result of printer failure or damage attributable to the use
of non-HP ink will not be covered under warranty.

Ink cartridge
1 Do not insert objects into these holes

Caution To prevent ink loss or spillage: leave the ink cartridges installed while
transporting the printer, and avoid leaving used ink cartridge(s) out of the printer
for extended lengths of time.

Ink cartridge warranty information
The HP ink cartridge(s) warranty is applicable when the product is used in its designated
HP printing device. This warranty does not cover HP ink products that have been refilled,
remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted
and the end of warranty date has not been reached. The end of warranty date, in YYYY/
MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see HP Warranty.
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Inserting or replacing the ink cartridges
1. Make sure the power is on, then lift the top cover. Make sure all packing material

has been removed from inside the printer.

2. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the
printer, then lift the latch.
The ink cartridge areas are color-coded for easy reference. Lift the latch below the
appropriate color to insert or replace a cartridge. From left to right, the ink cartridges
are black, yellow, light cyan, cyan, light magenta, and magenta.

1 Ink cartridge latch for the black ink cartridge
2 Ink cartridge area for the color ink cartridges

3. If you are replacing a cartridge, remove the old cartridge by pulling it toward you out
of its slot.

Recycle the old cartridge. The HP Inkjet Supplies Recycling Program is available in
many countries/regions and lets you recycle used ink cartridges free of charge. For
more information, go to www.hp.com/hpinfo/globalcitizenship/environment/recycle/
inkjet.html.

4. Remove the new ink cartridge from its packaging, and while holding it by the handle,
slide the ink cartridge into the empty slot.
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Make sure you insert the ink cartridge into the slot that has the same shaped icon
and color as the new cartridge. The copper-colored contacts should be facing the
printer as the ink cartridge is inserted.

Note The first time you set up and use the printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head
assembly.

5. Press down on the gray latch until it clicks into place.

6. Repeat steps 2 through 5 for each ink cartridge you are replacing.
You must install all six cartridges. The printer will not work if an ink cartridge is
missing.

7. Close the top cover.

Insert memory cards
After you have taken pictures with a digital camera, you can remove the memory card
from the camera and insert it into the printer to view and print your photos. The printer
can read the following types of memory cards: CompactFlash™, Memory Sticks,
Microdrive™, MultiMediaCard™, Secure Digital™, and xD-Picture Card™.

Caution Using any other type of memory card may damage the memory card
and the printer.

To learn about other ways of transferring photos from a digital camera to the printer,
see Connecting to other devices.

Supported file formats
The printer can recognize and print the following file formats directly from a memory card:
JPEG, uncompressed TIFF, Motion JPEG AVI, Motion-JPEG QuickTime, and MPEG-1.
If your digital camera saves photos and video clips in other file formats, save the files to
your computer and print them using a software program. For more information, see the
electronic Help.
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Inserting a memory card

Memory card slots
1 xD-Picture Card
2 Memory Stick
3 Compact Flash I and II, Microdrive
4 Secure Digital, MultiMediaCard (MMC)

Memory card types
Find your memory card in the following table and use the instructions to insert the card
into the printer.
Guidelines:
● Insert only one memory card at a time.
● Gently push the memory card into the printer until it stops. The memory card slot

allows for only a portion of the card to insert into the printer; do not try to force the
memory card all the way into the printer.

● When the memory card is inserted correctly, the memory card light flashes and then
remains solid green.

Caution 1 Inserting the memory card any other way may damage the card and
the printer.

Caution 2 Do not pull out a memory card while the memory card light is flashing
green. For more information, see Removing a memory card.

Memory card How to insert the memory card

CompactFlash ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first
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Memory card How to insert the memory card

Memory Stick ● Angled corner is on the left
● Metal contacts face down
● If you are using a Memory Stick Duo or Memory Stick PRO Duo

card, attach the adapter that came with the card before you insert
the card into the printer

Microdrive ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first

MultiMediaCard ● Angled corner is on the right
● Metal contacts face down

Secure Digital ● Angled corner is on the right
● Metal contacts face down

xD-Picture Card ● Curved side of card points toward you
● Metal contacts face down

Removing a memory card
Wait until the Memory Card light stops flashing, then gently pull the memory card to
remove it from the printer.

Caution Do not pull out a memory card while the Memory Card light is flashing.
A flashing light means that the printer is accessing the memory card. Removing
a memory card while it is being accessed may damage the printer and the memory
card or corrupt the information on the memory card.
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3 Printing photos without a
computer
The HP Photosmart D7100 series printer lets you select, enhance, and print photos
without even turning on the computer. Once you've set up the printer using the
instructions in the Quick Start Guide, you can insert a memory card in the printer and
print your photos using the buttons on the printer control panel.
You can also print photos directly from a digital camera. For more information, see Print
photos from a digital camera.

Printing photos
You can print photos without a computer in several different ways:
● Insert a memory card with photos on it into one of the memory card slots on the

printer
● Connect a PictBridge digital camera to the camera port on the front of the printer
● Install the optional HP Bluetooth® wireless printer adapter and print from a digital

camera with Bluetooth wireless technology

Print photos from a memory card
You can print photos from a memory card by inserting the card into the printer and using
the printer control panel to view, select, enhance, and print photos. You can also print
camera-selected photos—photos you marked for printing using a digital camera—
directly from a memory card.
Printing from a memory card is quick and easy, and does not drain the digital camera
batteries.

Print one or more photos
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select 4×6 or Enlargement to select your desired photo size, then press OK.
3. Select your desired paper size, then press OK.
4. Select a layout then press OK.
5. Using the arrow keys, scroll through the available photos.
6. Press OK to select one or more images.

– Press Zoom - to view up to 9 images on the printer screen.
– Press the up arrow to increase the number of prints for the selected image.

7. Press Print to print the selected photographs.
Check the Photo tray light to verify that the correct tray is selected — the light should be
off for the Main tray and on for the Photo tray.
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Print all photos on the memory card
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select Print All.
3. Select the desired paper size and press OK.

➔ Select a layout and press OK.
4. Select Print Now and press OK.

Print camera-selected photos from a memory card
When you select photos for printing using a digital camera, the camera creates a Digital
Print Order Format (DPOF) file that identifies the selected photos. The printer can read
DPOF 1.0 and 1.1 files directly from a memory card.
1. Use the digital camera to select the photos you want to print. For more information,

see the documentation that came with the camera.
2. If you select default as the photo layout with the camera, select Layout to select a

photo layout.
If you select a photo layout other than default with the camera, photos print in the
camera-selected layout regardless of the printer setting.

3. Load the desired paper.
4. Remove the memory card from the digital camera and insert it into the printer.
5. When a message appears on the printer screen asking if you want to print the

camera-selected photos, press OK.
The photos you selected with the camera begin printing.

If the printer cannot find or read all of the camera-selected photos on the card, it prints
the photos that it can read.
After printing, the printer deletes the DPOF file and unmarks the photos.

Print using the Wizard
The print wizard provides detailed instructions about selecting, sizing, editing, and
printing photographs.

Note Use the wizard to improve photo quality and apply advance effects such
as brightness and color effects.

1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the prompts to print your desired photo or photos.

Print photos from video clips
You can view video clips on the printer screen, and select and print individual frames.
When you first insert a memory card containing a video clip, the printer uses the first
frame of the video clip to represent the clip on the printer screen.
The printer recognizes video clips recorded in these formats:
● Motion-JPEG AVI
● Motion-JPEG QuickTime
● MPEG-1
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The printer ignores video clips in any other format.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. To select your desired photo size, select 4×6 or Enlargement then press OK.
3. Select your desired paper size and press OK.
4. Scroll to select the available videos using the left and right arrows.

Note Videos display a video camera icon in the center of the image.

5. Press the up arrow to play the video.
6. To select a frame to print, press the up arrow to pause the video. The video must

be paused to select frames for printing.
7. Press OK to select the desired frame for printing.
8. Press Print to print the selected frames.

Print a photo index
A photo index shows thumbnail views and index numbers for up to 2000 photos on a
memory card. Use plain paper instead of photo paper to reduce costs.
A photo index may be several pages long.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. Select Print All and press OK.
3. Select 8.5×11 paper.
4. Select the index sheet icon (16 images per page) and press OK.

Stop printing
To stop a print job in progress, press Cancel.

Print photos from a digital camera
You can print photos by connecting a PictBridge digital camera directly to the camera
port of the printer with a USB cable. If you have a digital camera with Bluetooth wireless
technology, you can insert the optional HP Bluetooth® wireless printer adapter in the
printer and send photos to the printer wirelessly.
When you print from a digital camera, the printer uses the settings that you selected on
the camera. For more information, see the documentation that came with the camera.

Digital camera with Bluetooth wireless technology
If you have a digital camera with Bluetooth wireless technology, you can purchase the
optional HP Bluetooth® wireless printer adapter and print from a camera using a Bluetooth
wireless connection.
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Note You can also print from other devices with Bluetooth wireless technology,
such as PDAs and camera phones. For more information, see Connecting to
other devices and the documentation that came with your Bluetooth adapter.

1. Set the Bluetooth options for the printer using the Bluetooth menu on the display.
For more information, see Settings.

2. Load printer paper.
3. Insert the HP Bluetooth® wireless printer adapter into the camera port on the front

of the printer.
The light on the adapter flashes when the adapter is ready to receive data.

4. Follow the instructions in the documentation that came with the digital camera to
send photos to the printer.

Digital camera with PictBridge technology
1. Turn on the PictBridge digital camera and select the photos you want to print.
2. Load paper.
3. Make sure the camera is in PictBridge mode, then connect it to the camera port on

the front of the printer using the USB cable that came with the camera.
Once the printer recognizes the PictBridge camera, the selected photos print
automatically.

Print photos from an iPod
If you have an iPod that can store photos, you can connect your iPod to the printer and
print the photos.

Before you begin
Check that the images you copy to the iPod are in JPEG format.

Note iPods might not be available in your country/region.

To import photos to an iPod
1. Copy photos from a memory card to your iPod using the Belkin Media Reader for

iPod.
2. Verify that photos are on your iPod by selecting Photo Import on the iPod menu.

Photos appear as Rolls.

To print photos from an iPod
1. Connect the iPod to the camera port on the front of the printer using the USB cable

that came with the iPod. The printer screen displays Reading Device for several
minutes while the photos are read. Then the photos appear on the printer screen.

2. Select the photo(s) you want to print and press Print. For more information on
selecting and printing photos, see Printing photos.

Photo layouts
Select the desired print function from the View & Print menu and press OK, choose your
desired print function, then select your desired paper size to select a layout.
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Layout Paper size (photo size)

1 per page borderless 4 x 6 inch (4 x 6 inch)
10 x 15 cm (10 x 15 cm)
5 x 7 inch (5 x 7 inch)
8.5 x 11 inch (8.5 x 11 inch)

1 per page 3.5 x 5 inch (3.25 x 4.75 inch)
4 x 6 inch (3.75 x 5.75 inch)
10 x 15 cm (9.53 x 14.6 cm)
5 x 7 inch (4.75 x 6.75 inch)
8 x 10 inch (7.75 x 9.75 inch)
8.5 x 11 inch (8 x 10 inch)
A6 (9.86 x 14.16 cm)
A4 (20 x 25 cm)
Hagaki (9.36 x 14.16 cm)
L (8.25 x 12.06 cm)

2 per page 3.5 x 5 inch (2.25 x 3.25 inch)
4 x 6 inch (2.75 x 3.75 inch)
5 x 7 inch (3.25 x 4.75 inch)
8 x 10 inch (4.75 x 6.5 inch)
8.5 x 11 inch (5 x 7 inch)
A6 (6.92 x 9.86 cm)
A4 (13 x 18 cm)
Hagaki (6.8 x 9.36 cm)
L (5.87 x 8.25 cm)

3 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.625 inch)
5 x 7 inch (2.25 x 3.375 inch)
8 x 10 inch (3.33 x 5 inch)
8.5 x 11 inch (4 x 6 inch)
A6 (4.77 x 7.15 cm)
A4 (10 x 15 cm)
Hagaki (4.52 x 6.78 cm)
L (3.96 x 5.94 cm)

4 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.5 inch)
5 x 7 inch (2.2 x 3.25 inch)
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Layout Paper size (photo size)
8 x 10 inch (3.5 x 4.75 inch)
8.5 x 11 inch (3.5 x 5  inch)
A6 (4.77 x 6.92 cm)
A4 (9 x 13 cm)
Hagaki (4.52 x 6.5 cm)
L (3.96 x 5.7 cm)

9 per page 3.5 x 5 inch (1 x 1.375 inch)
4 x 6 inch (1.125 x 1.5 inch)
5 x 7 inch (1.5 x 2 inch)
8 x 10 inch (2.25 x 3 inch)
8.5 x 11 inch (2.5 x 3.25 inch) – Wallet size
A6 (3.07 x 4.05 cm)
A4 (6.4 x 8.4 cm)
Hagaki (2.9 x 3.86 cm)
L (2.53 x 3.36 cm)

Note The printer may rotate the photos to fit the layout.

Improving photo quality
The printer provides a variety of enhancements that can improve the quality of a photo
printed from a memory card. These print settings do not change the original photo. They
only affect printing.

Adjust photos with poor brightness
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press

OK to view the menu.
4. Select Edit Photo and press OK.
5. Select Photo Brightness and press OK.
6. Press  and  to increase or decrease the photo brightness to the desired level,

then press OK.

Remove red eye from photos
The automatic red eye removal feature is enabled when you turn on the Photo fix function.
Enabling the Photo Fix function applies Smart Focus, Adaptive Lighting, and red eye
removal features to selected photos.
➔ Press Photo Fix to enable the Photo Fix function.

Adjust poor-quality video clips
This preference affects photos printed from video clips.
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Improve the quality of photos printed from video clips
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Using the arrow keys, find and select Video Enhancement and press OK.
4. Select On, then press OK.
For information about printing photos from video clips, see Print photos from a memory
card.

Getting creative
The printer provides a variety of tools and effects that let you use your photos in creative
ways. These print settings do not change the original photo. They only affect printing.

Add a color effect
You can set the printer to change the color option applied to a photo from Color (default)
to Black & white, Sepia, or Antique.
Photos printed in Sepia print in brown tones and look similar to photos produced in the
early 1900s. Photos printed in Antique print in the same brown tones, but with some
pale colors added to give the appearance that the photos are hand-colored.
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press

OK.
4. Select Done Selecting and press OK.
5. Select Edit Photo and press OK.
6. Select Color Effect and press OK.
7. Select the desired color effect and press OK.

Add the date and time to your prints
You can print a stamp on the front of your photos that shows when the photo was taken.
This preference affects all prints.
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Select Date Stamp and press OK.
4. Select one of the following date/time stamp options:

– Date and Time
– Date Only
– Off

If you use a computer to modify the photo and then save your changes, the original date
and time information are lost. Changes that you make to the photo using the printer
control panel do not affect the date and time information.

Change the print quality
You can change the print quality for photos. Best quality is the default and produces the
highest quality photos. Normal quality conserves ink and prints faster.
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To change the print quality:
1. Select Settings and press OK.
2. Select Preferences and press OK.
3. Select Print quality and press OK.
4. Select the desired print quality and press OK.
Print quality will revert to Best after the next print job.

Crop a photo
Press Zoom + and Zoom – to increase or decrease the magnification by 1.25×. The
maximum level is 5.0×.
1. Select View & Print and press OK.
2. Select 4×6 or Enlargement to select your desired photo size and press OK.
3. Select the desired paper size and press OK.
4. Select the desired photo and press OK.
5. Press Zoom + to increase the magnification of the photo by 1.25×. The green crop

box appears. Press Zoom + repeatedly until you reach the desired magnification.
(After zooming in, you can zoom back out by pressing Zoom –.)

Note The crop box changes from green to yellow if printing at the selected
magnification will noticeably reduce the print quality.

6. At any magnification level, press the arrows to move the crop box left, right, up, or
down.

7. Press OK when the portion of the image you want to print is in the crop box.
Cropping does not change the original photo. It only affects printing.

Print panoramic photos
1. Select View & Print and press OK.
2. Select Other Projects and press OK.
3. Select Panorama Prints and press OK.
4. Follow the prompt to load 10 x 30 cm (4 x 12 inch) media, then pressOK.
5. Select a photo and press OK. If desired, crop the photo before printing. The crop

box has a 3:1 aspect ratio.

Note All photos printed in panoramic mode are printed borderless.
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4 Getting connected
Use the printer to stay connected to other devices and people.

Connecting to other devices
This printer offers several ways of connecting to computers or other devices. Each
connection type lets you do different things.

Connection type and what you need This lets you...

Memory cards

A memory card

A compatible digital camera memory card
Insert the memory card into the
appropriate memory card slot on the front
of the printer.

● Print directly from a memory card to
the printer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software. For more
information, see Saving photos to a
computer and Print photos from a
memory card.

USB
● A Universal Serial Bus (USB) 2.0 full-

speed compliant cable 3 meters (10
feet) or less in length. For instructions
about connecting the printer with a
USB cable, see the Quick Start
booklet.

● A computer with Internet access (to
use HP Photosmart Share).

● Print from a computer to the printer.
See Printing from a computer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software.

● Share photos through HP Photosmart
Share.

● Print directly from an HP Photosmart
direct-printing digital camera to the
printer. For more information, see
Print photos from a digital camera and
the camera documentation.

PictBridge

The PictBridge symbol

Print directly from a PictBridge-compatible
digital camera to the printer.
For more information, see Print photos
from a digital camera and the camera
documentation.
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Connection type and what you need This lets you...
A PictBridge-compatible digital camera
and a USB cable.
Connect the camera to the camera port on
the front of the printer.

Bluetooth
The optional HP Bluetooth wireless printer
adapter.
If the printer came with this accessory or
you have purchased it separately, see the
accompanying documentation and the
onscreen Help for instructions.

Print from any device with Bluetooth
wireless technology—such as a digital
camera, a camera phone, or a PDA—to
the printer.
If you connect the optional HP Bluetooth
wireless printer adapter to the printer
through the camera port, be sure to set the
Bluetooth printer menu options as
needed. See Settings.

iPod
An iPod and the USB cable that came with
it. Connect the iPod to the camera port on
the front of the printer.

Print directly from an iPod (with photos
stored in it) to the printer. For more
information, see Print photos from an
iPod.
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Saving photos to a computer
You can save photos to a computer from any memory card inserted in the printer, if you
set up a USB connection between the two devices.

If you are using a Windows computer
Use either of these methods to save photos to your computer.
● Insert a memory card into the printer. The HP Photosmart Premier transfer software

(HP Transfer and Quick Print) opens on your computer screen and allows you to
designate a location on the computer to save images. For more information, see the
onscreen HP Photosmart printer software help.

● Insert a memory card into the printer. The memory card appears in Windows
Explorer as a removable drive. Open the removable drive and drag photos from the
card to any location on your computer.

If you are using a Macintosh
1. Insert a memory card into the printer.
2. Wait for iPhoto to start and read the contents of the memory card.

Note iPhoto starts only if it is set as the default application.

3. Click Import to save the photos on the card to your Macintosh.

Note The memory card also appears on the desktop as a drive icon. You can
open it and drag photos from the card to any location on your Macintosh.

Connecting through HP Photosmart Share
Use HP Photosmart Share to share photos with friends and relatives using e-mail, online
albums, or an online photo finishing service. Your printer must be connected through a
USB cable to a computer with Internet access and have all the HP software installed. If
you try to use Share and do not have all the required software installed or configured, a
message prompts you through the required steps.

Use Share (USB) to send photos (Windows users):
1. Insert a memory card and select some photos.
2. Select Share on the printer screen and press OK.
3. Follow the instructions on your computer to share the selected photos with others.

Use Share (USB) to send photos (Mac users)
1. Open HP Photosmart Studio and select photos to share. For information about

HP Photosmart Studio, see HP Photosmart Premier (Windows users).
2. In the HP Photosmart Studio toolbar, click Share.
3. Click Continue, and follow the instructions on your computer to share the selected

photos with others.
See the onscreen software help for more information about using HP Photosmart Share
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5 Printing from a computer
To print from a computer, the printer software must be installed. During software
installation, either HP Photosmart Premier (Windows Full-install users), HP Photosmart
Essential (Windows Express-install users) or the HP Photosmart Studio (Mac) is installed
on your computer, allowing you to organize, share, edit, and print photos.
For more information on installing the software, see the Quick Start Guide. Update the
software regularly to ensure you have the latest features and improvements; for
instructions, see Update the software.
To work with photos, you need to transfer them to a computer that is connected to the
printer. See Saving photos to a computer.

Note Windows users: HP Photosmart Premier can only be used on computers
with processors that have Intel® Pentium® III (or equivalent) and higher.

Using creative options in the printer software
Read through these tips on how to open and use HP Photosmart Premier, HP Photosmart
Essential, HP Photosmart Studio (Mac), and HP Photosmart Share.

HP Photosmart Premier (Windows users)
HP Photosmart Premier is an easy-to-use software program that gives you everything
you need to have fun with your photos, in addition to basic photo editing and printing.
This software also gives you access to HP Photosmart Share so that you can easily share
your photos.

Open HP Photosmart Premier
➔ Double-click the HP Photosmart Premier icon on your desktop. If you need help,

see the software help within HP Photosmart Premier.
Explore the many features of HP Photosmart Premier:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos in different sizes and in multiple layouts.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments using HP

Photosmart Share, a better way to send e-mail.
● Create — Easily create album pages, cards, calendars, panoramic photos, CD

labels, and more.
● Back-up — Make back-up copies of your photos to store and save.

HP Photosmart Essential (Windows users)
HP Photosmart Essential is an easy-to-use software program that gives you basic photo
editing and printing capabilities. This software also gives you access to HP Photosmart
Share so that you can easily share your photos. HP Photosmart Essential is only
available for Windows users.
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Open HP Photosmart Essential
➔ Double-click the HP Photosmart Essential icon on your desktop. If you need help,

see the software help within HP Photosmart Essential.
Explore the many features of HP Photosmart Essential:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos to make them perfect.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments with HP

Photosmart Share, a better way to send e-mail.

HP Photosmart Studio (Macintosh Users)
➔ Click the HP Photosmart Studio icon in the Dock.
Explore the many features of the HP Photosmart Mac software that is accessible from
the HP Photosmart Studio:
● Import — Import photos or videos from an HP digital camera.
● View and Manage — View, organize, and manage your photos and videos.
● Edit — Adjust and enhance your images.
● Slideshow — Create an online slideshow of your photos.
● Panorama — Create a single panoramic image from several images.
● Create — Create album pages, cards, labels, posters, banners, and more.
● Print — Print your photos and frames from video in standard sizes or in index sheet

format.
● Share — Send photos to family and friends without the bulky attachments.
● Shop — Order online prints and gifts.

HP Photosmart Share
HP Photosmart Share allows you to send photos to family and friends without bulky e-
mail attachments. For more information, see Connecting through HP Photosmart
Share and the HP Photosmart Premier or HP Photosmart Essential help.

Open HP Photosmart Share (Windows users)
➔ Click the HP Photosmart Share tab within HP Photosmart Premier or

HP Photosmart Essential.

Open HP Photosmart Share (Mac users)
➔ Click the Applications tab in HP Photosmart Premier, then double-click HP

Photosmart Share.

Set print preferences
Print preferences are set by default, but can be altered to suit your needs. You can set
specific job settings when you print from the computer. When you change settings before
printing, the changes only affect the current print job. In some Windows software
programs, you need to click Properties or Preferences within the Print dialog box to
access the advanced printing features. See the electronic Help for more information
about printing preferences.
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Access print preferences (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box tabs, or click Properties

or Preferences to access more printing preferences.

Access print preferences (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box by selecting the print options

you want to change in the Copies & Pages drop-down menu.
For more information on changing the printing preferences, see the electronic Help.

Open the electronic help

Windows users:
● Press F1 on your keyboard.
● For field-level help, click the ? in the top right corner of the Print dialog box.

Mac users:
1. From the Finder, choose Help > Mac Help.
2. Choose HP Photosmart Mac Help from the Library menu, and then choose the

printer name in the HP Photosmart Mac Help table of contents.

HP Real Life technologies features
Explore the many photo editing and enhancing options in the HP Real Life technologies
software features. These features—such as automatic red eye removal and adaptive
lighting—make it easy for you to print high-quality photos.
There are three options available:
● The Basic setting sharpens images and improves the quality and clarity of low

resolution images, such as those downloaded from the Internet.
● The Full setting improves images that are under exposed or over exposed, contain

dark areas or red eye, or have colors that appear washed out.
● The Off setting lets you edit the image manually in a software program such as

HP Photosmart software.

Access Real Life technologies features (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Click the Paper/Quality tab, then click the Real Life Digital Photography button

—OR— Click the Properties or Preferences button, and then click the Real Life
Digital Photography button.

Access Real Life technologies features (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Select Real Life Digital Photography from the Copies & Pages drop-down menu.
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6 Care and maintenance
The printer requires very little maintenance. Follow the guidelines in this section to extend
the life span of the printer and printing supplies, and to ensure that the photos you print
are always of the highest quality.
● Clean and maintain the printer
● Update the software
● Store and transport the printer and ink cartridges
● Maintain the quality of photo paper

Clean and maintain the printer
Keep the printer and print cartridge clean and well maintained using the simple
procedures in this section.

Clean the outside of the printer
1. Turn off the printer, then disconnect the power cord from the back of the printer.
2. Wipe the outside of the printer with a soft cloth that has been lightly moistened with

water.

Caution Do not use any type of cleaning solution. Household cleaners and
detergents may damage the printer finish. Do not clean the interior of the printer.
Keep all fluids away from the interior. Do not lubricate the metal rod on which the
print head slides. Noise is normal when the print head moves back and forth.

Aligning the printer
Use the following procedure when the self test report shows streaking or white lines
through any of the blocks of color.
If you still have print quality problems after aligning the printer, try cleaning the print head
using the procedure described in Care and maintenance. If print quality problems persist
after aligning and cleaning, contact HP Support.
1. Load letter or A4 unused plain white paper into the Main tray.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Scroll to find then select Align printer.

The printer aligns the print head, prints an alignment page, and calibrates the printer.
Recycle or discard the alignment page.

5. Press OK.

Print a sample page
You can print a sample page to test the printer photo printing quality and to make sure
the paper is loaded correctly.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Print sample page and press OK.
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Automatically clean the printhead
If you notice white lines or streaks on the photos you print, or in the color blocks of the
self test report, use this procedure to clean the print head. Do not clean the print head
unnecessarily, as this wastes ink and shortens the life of the ink nozzles on the print
head.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Clean printhead and press OK.
If print quality still seems poor after you clean the print head, try aligning the printer using
the procedure described in Aligning the printer. If print quality problems persist after
cleaning and aligning, contact HP support.

Manually clean the ink cartridge contacts
Clean the copper-colored ink cartridge contacts if a message appears on the printer
screen that says a cartridge is missing or damaged.
Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that
nothing is covering the ink cartridge contacts or the ink cartridge slot, then reinstall the
ink cartridge. If you continue to get a message that says a cartridge is missing or
damaged, clean the ink cartridge contacts. If you still get this message after cleaning the
contacts, you will need a replacement ink cartridge. Remove the affected ink cartridge
and look at the end-of-warranty date on the bottom, in YYYY/MMM/DD format. If it is
before the end-of-warranty date, contact HP support to obtain a replacement ink
cartridge.

To clean the ink cartridge contacts:
1. Gather the following items to clean the contacts:

– Distilled, filtered, or bottled water (tap water may contain contaminants that can
damage the ink cartridge)

Caution Do not use platen cleaners or alcohol to clean the ink cartridge
contacts. These can damage the ink cartridge or the HP Photosmart
printer printer.

– Dry foam rubber swabs, lint-free cloth, or any soft material that will not come
apart or leave fibers.

2. Open the top cover of the printer.
3. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the

printer, then lift the latch.

Caution Do not remove multiple ink cartridges at the same time. Remove
and clean each ink cartridge one at a time. Do not leave the ink cartridge
outside the printer for more than 30 minutes.

4. Lightly moisten a swab or cloth with water and squeeze out any excess water.
5. Hold the ink cartridge by its handle and gently wipe only the copper-colored contacts

with the swab or cloth.
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1 Gently wipe only the copper-colored contacts
6. Place the ink cartridge back into the empty slot and press down on the gray latch

until it clicks into place.
7. Repeat if necessary for the other ink cartridges.
8. Close the top cover.

Caution The ink supply may become pressurized. Inserting a foreign object into
the ink supply could result in ink being expelled and coming in contact with
persons or property.

Print a self test report
If you are experiencing problems with printing, print a self test report. This two-page report
—labelled the Extended Self Test Diagnostic Page—can help you diagnose printing
problems and can provide valuable information if you need to call HP Support. You can
also use this report to check on the approximate percentage of ink remaining in the ink
cartridges.
1. Select Settings and press OK.
2. Select Tools and press OK, then scroll to Print test page.
3. Select Print test page and press OK.
The HP Photosmart printer prints a two-page self test report that contains the following
information:
● Product information: Includes the model number, serial number, and other product

information.
● Revision information: Includes the firmware version number and indicates whether

or not you have an HP two-sided printing accessory (duplexer) installed.
● Ink delivery system information: Displays the approximate ink level of each

installed ink cartridge, the status of each ink cartridge, the date each cartridge was
installed, and the expiration date for each cartridge.

● Print head assembly information: Contains information that may be used for
diagnostic purposes if you need to call HP Support.

● Print head parameters: Contains information that may be used for diagnostic
purposes if you need to call HP Support.

● Print quality pattern: Displays six color blocks, representing each of the six
installed cartridges. When streaks appear through the color blocks, or there are
missing color blocks, clean the print head using the procedure described in Care
and maintenance. If the color blocks still show print quality problems after cleaning
the print head, align the printer using the procedure described in Aligning the
printer. If the color blocks continue to show print quality problems after cleaning and
aligning, contact HP support.

● History log: Contains information that may be used for diagnostic purposes if you
need to call HP Support.
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Self test report

Update the software
Download the latest printer software update periodically to ensure you have the latest
features and improvements. You can download printer software updates by going to
www.hp.com/support or by using HP Software Update.

Note The printer software update that you download from the HP Web site does
not update the HP Photosmart Premier software.

Downloading the software (Windows)

Note Make sure you are connected to the Internet before you use HP Software
Update.

1. From the Windows Start menu, select Programs (in Windows XP, select All
Programs) > Hewlett-Packard > HP Software Update. The HP Software Update
window opens.

2. Click Check Now. HP Software Update searches the HP Web site for printer
software updates. If the computer does not have the most recent version of the
printer software installed, a software update appears in the HP Software Update
window.

Note If the computer has the most recent version of the printer software
installed, the following message appears in the HP Software Update window:
“No updates are available for your system at this time”.

3. If a software update is available, click the checkbox next to the software update to
select it.

4. Click Install.
5. Follow the onscreen instructions to complete the installation.
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Downloading the software (Mac)

Note Make sure you are connected to the Internet before you use
HP Photosmart Updater.

1. On your Mac in the Finder, choose Go > Applications.
2. Choose Hewlett-Packard > Photosmart > HP Photosmart Updater.
3. Follow the onscreen instructions to check for software updates.

If you are behind a firewall, you need to enter the proxy server information in the
updater.

Store and transport the printer and ink cartridges
Protect the printer and ink cartridges by storing them properly when you are not using
them.

Store and transport the printer
The printer is built to withstand long or short periods of inactivity. Store the printer indoors
out of direct sunlight in a place without temperature extremes.

Caution To prevent ink loss or spillage: do not transport or store the printer on
its side, and leave the ink cartridges installed while storing and transporting the
printer.

Store and transport the ink cartridges
When you transport or store the printer, always leave the active ink cartridge inside the
printer to prevent the ink from drying out.

Caution 1 To prevent ink loss or spillage: leave the ink cartridges installed while
storing and transporting the printer, and avoid leaving used ink cartridge(s) out of
the printer for extended lengths of time.

Caution 2 Make sure the printer completes its power-down cycle before you
unplug the power cord. This allows the printer to store the print head properly.

Follow this tip to help maintain your HP ink cartridges and ensure consistent print quality:
Keep all unused ink cartridges in their original sealed packages until they are needed.
Store ink cartridges at room temperature (15-35 °C or 59-95 °F).

Maintain the quality of photo paper
For best results with photo paper, follow the guidelines in this section.

To store photo paper
● Store the photo paper in its original packaging or in a resealable plastic bag.
● Store the packaged photo paper on a flat, cool, and dry surface.
● Return unused photo paper to the plastic bag. Paper left in the printer or exposed

to the elements may curl.
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To handle photo paper
● Always hold photo paper by the edges to avoid fingerprints.
● If the photo paper has curled edges, place it in its plastic storage bag and gently

bend it in the opposite direction of the curl until the paper lies flat.

Chapter 6

44 HP Photosmart D7100 series



7 Troubleshooting
The HP Photosmart printer is designed to be reliable and easy to use. This chapter
answers frequently asked questions about using the printer and printing without a
computer. It contains information about the following topics:
● Printer hardware problems
● Printing problems
● Error messages
For additional troubleshooting information, see:
● Software installation troubleshooting: The Quick Start guide that came with the

printer.
● Printer software and printing from a computer troubleshooting: The onscreen

HP Photosmart Printer Help. For information about viewing the onscreen
HP Photosmart Printer Help, see Welcome.

Printer hardware problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Note If you want to connect the printer to a computer with a USB cable, HP
recommends using a 2.0 high-speed compliant cable 3 meters (10 feet) or less
in length.

The Print light is flashing blue but the printer is not printing
Solution The printer is busy processing information; wait for it to finish.

The Attention light is on

Solution
● Check the printer screen for instructions. If a digital camera is connected to the

printer, check the camera screen for instructions. If the printer is connected to
a computer, check the computer monitor for instructions.

● Turn off the printer, then unplug its power cord. Wait about 10 seconds, then
plug it in again. Turn on the printer.

If the Attention light stays on after trying the above solutions, go to www.hp.com/
support, or contact HP Support for help.
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The printer does not find the photos I stored on my memory card
Solution The memory card may contain file types the printer cannot read directly
from the card.
● Save the photos to a computer, then print them from the computer. For more

information, see the onscreen HP Photosmart printer help and the
documentation that came with the camera.

● The next time you take photos, set the digital camera to save them in a file
format the printer can read directly from the memory card. For a list of supported
file formats, see Printer specifications. For instructions on setting the digital
camera to save photos in specific file formats, see the documentation that came
with the camera.

The memory card may need to be reformatted if the problem persists.

The printer is plugged in but will not turn on

Solution
● The printer may have drawn too much power. Unplug the printer power cord.

Wait about 10 seconds, then plug the cord back in. Turn on the printer.
● The printer may be plugged into a power strip that is turned off. Turn on the

power strip, then turn on the printer.
● The power cord could be defective. Make sure the green light on the power cord

is lit.

The printer makes noises when I turn it on, or starts making noises after sitting
unused for a while

Solution The printer may make noises after long periods of inactivity
(approximately 2 weeks) or when its power supply has been interrupted and then
restored. This is normal operation. The printer is performing an automatic
maintenance procedure to ensure it produces the best quality output.

All the lights are flashing on the printer
Solution The printer has encountered a hardware error and may need to be
serviced. Unplug the power cord to the printer. Wait about 10 seconds, and then
plug it in again. Turn on the printer. If the lights are still flashing, please go to
www.hp.com/support, or contact HP Support for help.

Printing problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
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The printer does not print borderless photos when I print from the control panel
Solution Make sure the correct layout is selected when setting up the print job.
When selecting photo and paper size, the image rectangle must be solidly filled with
orange to indicate a borderless print.

Printing is very slow
Solution You may have one of the following situations: 1) you may be printing a
PDF or a project containing high-resolution graphics or photos or 2) you may have
selected the highest resolution for your printout. Large, complex projects containing
graphics or photos print slower than text documents, especially at higher resolutions.

Paper does not feed into the printer correctly from the Main tray

Solution
● There may be too much paper loaded in the tray. Remove some paper and try

printing again.
● The Main tray may not be pushed in all the way. Push the Main tray all the way

in.
● The paper guides may not be adjusted correctly. Make sure the paper-width

and paper-length guides fit close to the edges of the paper without bending the
paper.

● Two or more pieces of paper may be sticking together. Remove the paper from
the Main tray, fan the edges of the stack to separate the sheets of paper, then
reload the paper and try printing again.

● If the paper is wrinkled or bent, try using different paper.
● The paper may be too thin or too thick. Use HP inkjet paper for best results. For

more information, see Choose the right paper.

Printed pages are dropping off of the Output tray
Solution Always extend the Output tray extension when you print.

The printout is rippled or curled
Solution The project you are printing uses a larger amount of ink than normal.
Print the project from a computer, and use the printer software to lower the ink
saturation level. See the onscreen HP Photosmart printer help for more information.

The document printed at an angle or is off-center

Solution
● The paper may not be loaded correctly. Reload the paper, making sure it is

correctly oriented in the Main tray and that the paper-width and paper-length
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guides fit close to the edges of the paper. For paper-loading instructions, see
Paper loading tips.

● If you are using a two-sided printing accessory, try removing it, replacing the
rear access door, and printing again.

● The printer may need to be aligned. For more information, see Aligning the
printer.

Colors are not printing satisfactorily

Solution
● One of the color ink cartridges may be empty, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is empty, replace it. For more information, see Insert ink
cartridges.

● The printer may need to be aligned. For more information, see Aligning the
printer.

● The print head may need to be cleaned. For more information, see Care and
maintenance.

No page came out of the printer or the paper jammed while printing

Solution
● The printer may need attention. Read the printer screen for instructions.
● The power may be off or there may be a loose connection. Make sure the power

is on and the power cord is securely connected.
● You may not have any paper in the Main tray or Photo tray. Check that the paper

is loaded correctly. For paper-loading instructions, see Paper loading tips.
● If the paper jammed while printing, try the following:

– Turn off the printer, then unplug it from the power source. Clear the printer
of any paper obstructing the paper path. Remove the rear access door.
Gently remove the jammed paper from the printer, then replace the rear
access door. If all jammed paper cannot be removed from the rear area of
the printer, try removing paper jammed in the middle of the printer by
opening the paper jam door located inside the top cover. For illustrations
of the two places to clear a paper jam, see Paper errors. When you are
finished clearing the paper jam, plug the printer back in, turn it on, and try
printing again.

– If you were printing labels, make sure a label did not become unglued from
the label sheet while going through the printer.

A blank page came out of the printer

Solution
● You may have begun printing and then cancelled the print job.
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If you cancelled the print job before printing started, the printer may have already
loaded paper in preparation for printing. The next time you print, the printer
ejects the blank page before starting the new printing project.

● A print job with a large amount of data may have been sent to the printer.
Wait for the printer to service the print head before it continues printing.

The printer asked me to print an alignment page
Solution Periodically, the printer needs to perform a print head alignment to
maintain optimal print quality.
When prompted, load plain letter or A4 paper. Discard or recycle the alignment page.

The photo did not print using the default print settings
Solution You may have changed the print settings for the selected photo. Print
settings you apply to an individual photo override the default print settings. Discard
all print settings that have been applied to an individual photo by deselecting the
photo. For more information, see Settings.

The printer ejects the paper when preparing to print
Solution Direct sunlight could be interfering with the operation of the automatic
paper sensor. Move the printer out of direct sunlight.

Print quality is poor

Solution
● One of the ink cartridges may be very low on ink, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is low on ink, replace it. For more information, see Insert ink
cartridges.

● Use photo paper designed for the printer. For best results, use the papers
recommended in Choose the right paper.

● You may be printing on the wrong side of the paper. Make sure the paper is
loaded with the side to be printed facing down.

● You may have selected a low-resolution setting on the digital camera. Reduce
the size of the image and try printing again. For better results in the future, set
the digital camera to a higher photo resolution.

● There may be a problem with an ink cartridge or with the print head. Try the
following:
– Remove and then reinsert each ink cartridge, one at a time, to make sure

they are all properly seated.
– Run the automatic print head cleaning procedure. For more information,

see Care and maintenance.
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– Align the printer. For more information, see Aligning the printer.
– If print quality problems persist after you have tried all of the above

solutions, contact HP Support.

Photos are not printing correctly

Solution
● You may have loaded the photo paper incorrectly. Load the photo paper with

the side to be printed facing down.
● The photo paper may not have fed into the printer correctly. Try the following:

– Check for a paper jam. For more information, see Paper errors.
– Insert the photo paper as far as it will go into the Photo tray.
– Load one sheet of photo paper at a time.

The photos I marked for printing in the digital camera do not print
Solution Some digital cameras let you mark photos for printing in both the
camera's internal memory and on the memory card. If you mark photos in the internal
memory, and then move photos from the camera's internal memory to the memory
card, the marks do not transfer. Mark photos for printing after you transfer them from
the digital camera's internal memory to the memory card.

Error messages
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
Error messages that appear on the printer screen can be divided into the following types:
● Paper errors
● Ink cartridge errors
● Memory card errors
● Computer printing errors

Paper errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Paper jam. Clear jam then press OK.
Solution Turn off the printer, then unplug it from the power source. Clear the
printer of any paper that may be obstructing the paper path. Remove the rear access
door. Gently remove the jammed paper from the printer, then replace the rear access
door.
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1 Remove the rear access door to clear paper jams.

If you cannot remove all jammed paper from the rear area of the printer, try removing
paper jammed in the middle of the printer by opening the paper jam door located
inside the top cover.

1 Open the paper jam door to clear paper jams in the middle of the printer.

Plug the printer back in and turn it on.

Error message: Out of paper. Load paper then press OK.
Solution Load paper, then press OK to print again. For paper-loading instructions,
see Paper loading tips.

Error message: Unsupported media size.
Solution The printer cannot use the size of paper loaded in the paper tray.
Press OK, then load a supported paper size instead. For a list of supported paper
sizes, see Printer specifications.

Error message: Automatic paper sensor failed.
Solution The automatic paper sensor is obstructed or damaged. Try moving the
printer out of direct sunlight, then press OK and try printing again. If this does not
work, go to www.hp.com/support or contact HP Support.

HP Photosmart D7100 series User Guide 51

http://www.hp.com/support


Ink cartridge errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Wrong ink cartridge(s) installed
Solution The first time you set up and use your HP Photosmart printer printer,
make sure to install the ink cartridges that were shipped with your printer. The ink
in these ink cartridges is specially formulated to mix with the ink in the print head
assembly.
To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with your HP Photosmart printer printer.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Incorrect ink cartridge
Solution The indicated ink cartridge(s) cannot be used after the device has
undergone initialization. Replace the ink cartridge(s) with the appropriate ink
cartridges for your HP Photosmart printer. The cartridge numbers you can use with
this printer appear on the back cover of this printed guide.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Replace cartridges soon
Solution The indicated ink cartridge(s) are empty.
You might be able to continue printing for a short period of time with ink remaining
in the print head assembly. Replace the indicated ink cartridge(s) or press OK to
continue.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge(s) are empty
Solution The indicated ink cartridge(s) are empty and there is not enough ink in
the printhead reservoir for normal printing and servicing tasks. Replace the indicated
ink cartridge(s) with new ink cartridge(s).
● If the black ink cartridge is empty, you can continue printing with the other color

ink cartridges by selecting that option in the displayed printer screen prompts.
● If a color ink cartridge is empty, you can continue printing with the black ink

cartridge by selecting that option in the displayed printer screen prompts.
Depending on the status of your print job, you can press OK to continue. If the HP
Photosmart printer is in the middle of a print job, press Cancel and restart your print
job.

Note Text and photo quality will differ from those printed when using all ink
cartridges. If the empty ink cartridge(s) are not replaced soon, all printing will
stop.
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For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Cannot print
Solution The indicated ink cartridge(s) are out of ink.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
The HP Photosmart printer cannot continue printing until the indicated ink cartridge
(s) are replaced. All printing will stop.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge problem
Solution The indicated ink cartridge(s) are missing or damaged.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
If there are no ink cartridges missing from the HP Photosmart printer, the ink
cartridge contacts might need to be cleaned.
For more information on replacing ink cartridges, see Insert ink cartridges. For more
information on cleaning the ink cartridge contacts, see Care and maintenance.
If there are no ink cartridges missing from the HP Photosmart printer, and you still
receive this message after cleaning the ink cartridge contacts, you will need a
replacement ink cartridge. Remove the affected ink cartridge and look at the end-
of-warranty date on the bottom, in YYYY/MMM/DD format. If it is before the end-of-
warranty date, contact HP Support to obtain a replacement ink cartridge.

Error message: Ink Expiration Nearly Expired. —OR— Ink Cartridge(s) Expired.
Solution Each ink cartridge has an expiration date. The purpose of expiration is
to protect the printing system and to ensure ink quality. When you receive an ink
expiration message, remove and replace the ink cartridge, and then close the
message. You can also continue printing without replacing the ink cartridge, by
following the instructions on your computer screen. HP recommends replacing the
expired ink cartridges. HP cannot guarantee the quality or reliability of expired ink
cartridges. Device service or repairs required as a result of using expired ink will not
be covered under warranty.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Non-HP ink
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.
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If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Original HP ink depleted
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Scheduled maintenance
Solution You must align the printer to ensure excellent print quality. With letter or
A4 unused plain white paper in the Main tray, press OK. The HP Photosmart printer
aligns the print head, calibrates the printer, and then prints a test page. Recycle or
discard the test page.

Error message: Calibration error

Solution
● If you have color or photo paper loaded in the Main tray when you align the

printer, the alignment might fail. Load unused plain white letter or A4 paper into
the Main tray, and then try the alignment again. If the alignment fails again, you
might have a defective sensor or ink cartridge; contact HP Support.

● The ink cartridge or sensor is defective. Contact HP support.

Error message: Print cartridge cradle is stuck
Solution Remove any objects that are blocking the print head assembly.

To clear the print head assembly
1. Open the top cover, then open the paper jam door.
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1 Open the paper jam door to clear the print head assembly.
2. Remove any objects that are blocking the print head assembly, including paper

and any packing materials.
3. Turn the printer off, then turn it on again.
4. Close the paper jam door and the top cover.

Error message: Ink System Failure
Solution The print head assembly or the ink delivery system has failed and the
HP Photosmart printer can no longer print.
Turn off the printer, then unplug its power cord. Wait about 10 seconds, then plug it
in again. If this does not clear the error message, please contact HP Support.

Memory card errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Photo is missing. —OR— Some photos are missing.
Solution The printer cannot read the file on the memory card, or one or more files
specified for the job are missing from the memory card. Try saving the photos to the
computer using the digital camera rather than the memory card. If a photo is missing,
you may have accidentally deleted the photo from the card.
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Error message: Card access error. Job was cancelled. Press OK.—OR— File
directory structure is corrupted. —OR— Card may be damaged. Job was
cancelled. Press OK.

Solution The printer cannot read the data on the memory card and cannot
complete any current print jobs. The data may be corrupted or there may be a
physical problem with the memory card.
● Save the files to the computer and access them from there.
● If this does not work, use a new memory card or reformat the memory card

using the digital camera. Any photos on the memory card will be lost.
● If this does not work, the photo files may be damaged or unreadable. Before

you contact HP Support, try another memory card to determine if it is the printer
or the memory card that is failing.

Error message: Cannot print photos.
Solution More than 10 photos specified for a print job may be corrupted, missing,
or are an unsupported file type. For information about supported file types, see
Printer specifications.
● Save the photos to the computer using the digital camera rather than the

memory card.
● Save the files to the computer and print from the computer.
● Print a photo index and reselect photos. For more information, see Printing

photos.

Error message: Card is password protected. Cannot access card.
Solution The printer cannot read the memory card because the card is password-
protected. Follow these steps:
1. Remove the memory card from the printer.
2. Insert the memory card in the device you originally used to store the password

on the memory card.
3. Remove the password from the memory card.
4. Remove the memory card and reinsert it in the printer memory card slot.
5. Try printing again.

Error message: Card is locked. Cannot access card.
Solution Make sure the lock switch on the card is in the unlocked position.

Error message: Card is not fully inserted. Push card in a little more.
Solution The printer can detect the memory card but cannot read it. Push the
memory card gently into the memory card slot until it stops. For more information,
see Insert memory cards.
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Error message: Use only one (1) card at a time. Please remove a memory card. —
OR— Use only one (1) device at a time. Please remove/disconnect a device.

Solution The printer has two or more different types of memory cards inserted
simultaneously, or a memory card is inserted and a digital camera is connected to
the camera port at the same time. Remove memory cards or disconnect the camera
until only one card is in the printer or only a camera is connected.

Error message: Card was removed. Job was cancelled. Press OK.
Solution You removed a memory card from the printer while it was busy printing
a file from the card. Follow these steps:
1. Press OK.
2. Reinsert the memory card and print the selected photos again. The memory

card must remain inserted until the print job is complete.
To avoid damage to memory cards in the future, do not remove them from the printer
memory card slot while they are being accessed. For more information, see
Removing a memory card.

Error message: Camera selections (DPOF) file has error.
Solution The printer is unable to read a DPOF file due to corrupted data or an
error on the memory card. Use the printer control panel to reselect the photos. For
more information, see Print photos from a memory card.

Error message: Some camera-selected photos are not on card.
Solution Some camera-selected photos are missing or have been deleted. Try
the following:
● Confirm that you did not accidentally delete the photo from the memory card.
● Reselect the photos again using the digital camera.
● Print a new photo index to see the index numbers associated with each photo.

For more information, see Printing photos.

Error message: Cannot display this photo. —OR— Cannot display all photos. —
OR— Photos are corrupted.

Solution The memory card contains image formats the printer does not support,
or the files are corrupted. For a list of supported image formats, see Printer
specifications. Access photos using the computer. For information about accessing
photos through the computer, see Printing from a computer.

Error message: Unsupported card type.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer.
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Error message: Some photo numbers are not on card.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer. If some photos are still missing, they may have been deleted
from the memory card.

Computer and connectivity printing errors
Before contacting HP Support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Printer memory is full. Job was cancelled. Press OK.
Solution The printer encountered a problem when printing photos. Try the
following:
● To clear the printer memory, turn the printer off, then turn it on again.
● Print fewer photos at a time.
● Save the photos to the computer and print from there.
● Save the files to the computer using a memory card reader and then print from

the computer.

Error message: Communication error. Check computer connection. Press OK. —
OR— Data was not received. Check computer connection. Press OK to continue.
—OR— No response from computer.

Solution The printer cannot communicate properly with the computer. The printer
software may not be working or a cable may be loose. Make sure the USB cable is
securely attached to both the computer and to the USB port on the back of the printer.
If the cable is secure, verify that the printer software is installed.

Error message: Camera disconnected during print job.
Solution The print job will be cancelled. Reattach the USB cable to the camera
and printer and resend the print job.
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8 HP support
Support process

If you have a problem, follow these steps:
1. Check the documentation that came with the HP Photosmart printer.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is

available to all HP customers. It is the fastest source for up-to-date device
information and expert assistance and includes the following features:
– Fast access to qualified online support specialists
– Software and driver updates for the HP Photosmart printer
– Valuable HP Photosmart printer and troubleshooting information for common

problems
– Proactive device updates, support alerts, and HP newsgrams that are available

when you register the HP Photosmart printer
3. For Europe only: Contact your local point of purchase. If the HP Photosmart printer

has a hardware failure, you will be asked to bring it back to your local point of
purchase. (Service is provided at no charge during the device limited warranty
period. After the warranty period, you will be quoted a service charge.)

4. Call HP support. Support options and availability vary by device, country/region, and
language.

HP support by phone
For a list of support phone numbers, see the phone number list on the inside of the front
cover.

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America
(including Mexico). To determine the duration of phone support in Europe, the Middle
East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP Photosmart printer.
Be prepared to provide the following information:
● Device model number (located on the label on the front of the device)
● Device serial number (located on the back or bottom of the device)
● Messages that appear when the situation occurs
● Answers to these questions:

– Has this situation happened before?
– Can you re-create it?
– Did you add any new hardware or software to your computer at about the time

that this situation began?
– Did anything else occur prior to this situation (such as a thunderstorm, device

was moved, etc.)?
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After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may
also be available at the HP online support Web site: www.hp.com/support. Contact your
HP dealer or call the support phone number for your country/region to learn more about
support options.
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A Specifications
This section lists the minimum system requirements for installation of the HP Photosmart printer
software, and provides selected printer specifications.
For a complete list of printer specifications and system requirements, see the onscreen
HP Photosmart Printer Help. For information about viewing the onscreen HP Photosmart printer
help, see Welcome.

System requirements

Component Windows PC minimum Macintosh minimum

Operating system Microsoft® Windows 98, 2000
Professional, Me, XP Home,
and XP Professional

Mac® OS X 10.3, 10.4, and
later

Processor Intel® Pentium® II (or
equivalent) and higher

G3, G4, G5 or Intel Core Duo
or greater

RAM 64 MB (128 MB
recommended)

Mac OS X 10.3, 10.4, and
later: 128 MB

Free disk space 500 MB 150 MB

Video display 800 x 600, 16-bit or higher 800 x 600, 16-bit or higher

CD-ROM drive 4x 4x

Connectivity USB: Microsoft Windows 98,
2000 Professional, Me, XP
Home, and XP Professional
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

USB: Front and back ports
(Mac OS X 10.3, 10.4, and
later)
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

Browser Microsoft Internet Explorer 5.5
or later

—

Printer specifications

Category Specifications

Connectivity USB: Microsoft Windows 98, 2000 Professional, Me, XP
Home, and XP Professional; Mac OS X 10.3, 10.4, and later

Image file formats JPEG Baseline
TIFF 24-bit RGB uncompressed interleaved
TIFF 24-bit YCbCr uncompressed interleaved
TIFF 24-bit RGB packbits interleaved
TIFF 8-bit gray uncompressed/packbits
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Category Specifications
TIFF 8-bit palette color uncompressed/packbits
TIFF 1-bit uncompressed/packbits/1D Huffman

Video file formats Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

Media specifications Recommended maximum length: 61 cm (24 inch)
Recommended maximum paper thickness: 292 µm (11.5
mil)
Recommended maximum envelope thickness: 673 µm
(26.5 mil)

Media sizes supported Supported sizes when printing from a computer
7.6 x 12.7 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Supported sizes when printing from the control panel
Metric: A6, A4, 10 x 15 cm (with and without tab); Imperial:
3.5 x 5 inch, 4 x 6 inch (with and without tab), 4 x 12 inch,
5 x 7 inch, 8 x 10 inch, 8.5 x 11 inch; Other: Hagaki and L-
size

Media types supported Paper (plain, inkjet, photo, and panoramic photo)
Envelopes
Transparencies
Labels
Cards: index, greeting, Hagaki, A6, L-size
Iron-on transfers
Avery C6611 and C6612 photo sticker paper: 10 x 15 cm
(4 x 6 inch), 16 rectangular or oval stickers per page

Memory cards CompactFlash Type I and II
Microdrive
MultiMediaCard
Secure Digital
Memory Sticks
xD-Picture Card

Memory card-supported file
formats

Printing: See Image file formats earlier in this table.
Saving: All file formats

Paper tray – media sizes
supported

Main tray
8 x 13 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Photo tray
Up to 10 x 15 cm (4 x 6 inch), with or without tab
Output tray
All supported Main tray and Photo tray sizes

Paper tray capacity Main tray
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Category Specifications
100 sheets of plain paper
14 envelopes
20–40 cards (depending on thickness)
30 sheets of labels
25 transparencies, iron-on transfers, or photo paper
10 sheets of photo paper
Photo tray
Output tray
20 sheets of photo paper
50 sheets of plain paper
10 cards or envelopes
25 sheets of labels or iron-on transfers

Operating environment Recommended temperature range: 15–30 °C (59-86 °F)
Maximum temperature range: 5–40 °C (41-104 °F)
Storage temperature range: -40–60 °C (-40-140 °F)
Recommended humidity range: 20–80% RH
Maximum humidity range: 10–80% RH

Physical specifications Height: 17.9 cm (6.8 inch).
Width: 46.25 cm (18.2 inch)
Depth: 38.7 cm (15.25 inch)
Weight: 7.7 kg (17.0 lb).

Power consumption Printing, Average: 75 W
Printing, Maximum: 94 W
Idle: 13.3–16.6 W

Power supply model number HP Part # 0957-2105

Power requirement 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

Ink cartridges HP Yellow Ink Cartridge
HP Cyan Ink Cartridge
HP Light Cyan Ink Cartridge
HP Magenta Ink Cartridge
HP Light Magenta Ink Cartridge
HP Black Ink Cartridge

Note The cartridge numbers you can use with this
printer appear on the back cover of this printed
guide. If you have already used the printer several
times, you can also find the cartridge numbers in
the printer software. For more information, see
Insert ink cartridges.

Print speed (maximum) Black printouts: 32 pages per minute
Color printouts: 31 pages per minute

(continued)
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Category Specifications
Photos: 14 seconds for each 10 x 15 cm (4 x 6 inch) photo

USB support Microsoft Windows 98, 2000 Professional, Me, XP Home,
and XP Professional
Mac OS X 10.3, 10.4, and later
HP recommends using a USB 2.0 full-speed compliant
cable 3 meters (10 feet) or less in length.
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B HP Warranty
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A. Extent of limited warranty
  1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from 

defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase 
by the customer.

  2. For software products, HP's limited warranty applies only to a failure to execute programming instructions. HP does 
not warrant that the operation of any product will be interrupted or error free.

  3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover 
any other problems, including those that arise as a result of:

   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
  4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty to the 

customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use 
of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for 
the particular failure or damage.

  5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

  6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, 
within a reasonable time after being notified of the defect, refund the purchase price for the product.

  7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
  8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the 

product being replaced.
  9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.
  10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts 

for additional warranty services, such as on-site service, may be available from any authorized HP service facility in 
countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE.

C. Limitations of liability
  1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and 

exclusive remedies.
  2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN 

THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 

   SUCH DAMAGES.
D.  Local law
  1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary 

from state to state in the United States, from province to province in Canada, and from country to country elsewhere 
in the world.

  2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed 
modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this W
Statement may not apply to the customer. For example, some states in the United States, as well as some 
governments outside the United States (including provinces in Canada), may:

   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer 
    (e.g., the United Kingdom);
   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer 

cannot disclaim, or allow limitations on the duration of implied warranties.
 3.  THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT

EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date printed 
 on the cartridge has been reached, whichever occurs first. This 

warranty does not cover HP ink products that have been refilled, 
remanufactured, refurbished, misused, or tampered with.

Accessories 90 days
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Index

A
accessories 11
accessories, two-sided

printing 11
after the support period 60
aligning the printer 39
alignment page 39
alignment, required 54
antique coloration 29

B
Bluetooth

connecting to printer 23,
31

menu settings 11
wireless printer adapter

11
borderless prints 29
buttons 10

C
calling HP support 59
cameras

connecting to printer 23,
31

direct-printing 25
PictBridge 25
port 8
printing from 25

care and maintenance 39
cartridges. See ink cartridges
cleaning

copper-colored contacts
40

print head 40
printer 39

color effects 29
CompactFlash 20
computer

connecting to printer 31
printing from 35
saving photos to 33
system requirements 61

control panel 10

D
damaged, ink cartridge 53

date and time stamps 29
digital cameras. See cameras
Digital Print Order Format 24
documentation, printer 7
DPOF 24

E
e-mailing photos 33
energy consumption 2
Energy Star 2
error messages 50

F
file formats, supported 20, 61
Frequently asked questions

45

G
Getting help 45

H
Help 45
Hewlett-Packard Company

notices 2
home, screen 11
HP direct-printing digital

cameras 25
HP Instant Share 31
HP Photosmart Essential 35
HP Photosmart Premier 35
HP Photosmart Share 33, 36
HP Photosmart Studio (Mac

only) 36
HP Software Update 42

I
ink

checking level 41
empty 52
replace soon 52

ink cartridges
damaged 53
empty 52
expired 53
HP ink depleted 54
incorrect 52
ink level, checking 19

inserting 19
missing 53
non-HP ink 53
printer alignment 54
replace soon 52
replacing 19
storing 43
testing 41

ink level, checking 19
inserting

ink cartridges 19
memory cards 21

iPod 32

J
JPEG file formats 20

L
layout and photo size 26
lights 10
Load paper 15

M
Macintosh

HP Photosmart Mac
software 36

memory cards
inserting 21
printing from 23
removing 22
saving photos to a

computer 33
supported types 20

Memory Sticks 20
Microdrive 20
missing ink cartridge 53
MPEG-1 file format 20
MultiMediaCard 20

P
Paper

load 15
paper

buying and choosing 15
maintaining 15, 43
specifications 61
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trays 8
phone support 59
phone support period

period for support 59
photos

antique coloration 29
cropping 29
date and time stamp 29
e-mailing 33
framing 29
improving quality 28
printing 23
saving to computer 31
sepia tones 29
supported file formats 20
zooming 29

Photosmart Share. See
HP Photosmart Share

PictBridge cameras 25
placing a call 59
print head

cleaning 40
failure 55
stalled 54

print quality
changing 23

Printer
Specifications 61

printer
accessories 11
care and maintenance 39
cleaning 39
connecting 23, 31
documentation 7
error messages 50
home 11
parts 8
specifications 61
storing 43

printer software
updating 42

printer software, updating 35
printing

from a computer 35
from BlueTooth device 23
from cameras 25
from memory cards 23
from PictBridge camera

23
photos 23
range of photos 23
test page 41
without computer 23

Q
quality

photo paper 43
photos 28
printing test page 41

Questions and Answers 45

R
range

printing 23
regulatory notices

regulatory model
identification number 2

removing memory cards 22
replacing ink cartridges 19

S
saving photos to computer 31
Secure Digital 20
sepia tones 29
Sony Memory Sticks. See

Memory Sticks
Specifications 61
storing

ink cartridges 43
photo paper 43
printer 43

support 59
support process 59
system requirements 61

T
test page 41
TIFF file format 20
transporting printer 11
trays, paper 8
Troubleshooting 45
troubleshooting

error messages 50
two-sided printing 11

U
USB

connection type 31
port 8
specifications 61

V
video clip

supported file formats 20

X
xD-Picture Card 20
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